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⮚ INTRODUCTION 

The Manual for the production of “didactic pills” usable on mobile devices is developed 

as a result of “4G Didactic pills” project. The project is co-funded by the Erasmus+ Program, 

KA2 - Cooperation for innovation and the exchange of good practices, KA201 - Strategic 

Partnerships for school education. 

The Manual will introduce teachers into methodology of production of didactical 

materials usable on a technological device. It aims to become a useful tool in the hands of 

teachers in Secondary schools, covering various aspects of interactive tools. The Manual will 

prepare them to produce didactical materials related to life skills in the form of didactic pills 

usable on a technological device that will be effective for integration of SEN students 

(recommendations, policies, case studies, etc.). 

Different studies comment on the four characteristics of pedagogical approaches in 

connection with the use of ICT that youngsters have an affinity with: 1) they want more 

interactive content, more dynamism in the ways of teaching 2) they want to be stimulated by 

different visual and audio stimuli and related to interactive and participatory teaching 

approaches that encourage inclusion and engagement 3) they need approaches that challenge 

them, for example through didactic games, where young people can see a direct benefit from 

the approaches and content 4) they want approaches that can empower them individually to 

monitor and manage their lives. 

With these functions, mobile can replace specific assistive technologies in some cases: for 

example, students with autism or speech disorder can use mobiles with app (Schaffhauser, 

2013). Unlike earlier technologies for students with special needs, the mobiles are 

indistinguishable from devices used by other students (Robinson, June 2014). Therefore, 

mobiles have the potential to become a powerful inclusive device. They can serve as a bridge 

between students with and without disabilities (Dwight, 2013). Another advantage is that 

using mobiles and free applications is much less expensive than assistive technologies. 
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Life skills are defined as “a group of psychosocial competencies and interpersonal skills 

that help people make informed decisions, solve problems, think critically and creatively, 

communicate effectively, build healthy relationships, empathize with others, and cope with 

and manage their lives in a healthy and productive manner. Life skills may be directed toward 

personal actions or actions toward others, as well as toward actions to change the surrounding 

environment to make it conducive to health.” according to World Health Organization (WHO). 

The Manual will help the teachers get into different technological approaches that are 

used in producing of content for didactical materials related to life skills in the form of didactic 

pills usable for online teaching and usable of mobile devices. 

The 4G Didactic Pills provide easily accessible tools to address the challenges/demands of 

everyday life that youth face, from managing their emotions to making informed decisions. It 

also helps to develop children's personality, talents and mental and physical abilities and 

realize their true potential by learning to know themselves and others and make effective 

decisions to live harmoniously together in society.   
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⮚ Chapter 1. Pedagogical Model 

o 1.1. The use of didactic pills as a pedagogical method.  

A growing phenomenon that is happening in schools is the loss of concentration by 

students. Nowadays, the number of elements that favour the distraction of the student has 

increased with respect to previous decades. Computers, smartphones, tablets, video games, 

etc. are legally making it difficult to sit down to study for hours at a time. However, for many 

experts, new technologies will not hinder learning. Simply, knowledge will be assimilated 

differently. The human being evolves towards a kind of “multitasking learning”. This means 

that the information will no longer be concentrated in one place (the page of a textbook), but 

that the student will assimilate small doses of information at the same time and from different 

media. The Internet itself acts as a huge virtual micro-learning academy. Taking as an example 

the average citizen who sits down every day for several hours to navigate, we see how we 

receive training pills constantly and unconsciously.  

From the moment you search for a video tutorial on a specific topic, you will jump from 

one page to another browsing an endless maze of information: other related videos and blogs, 

news, downloadable courses, content shared on social networks, etc. The human brain adapts 

to collect these mircro-contents from the great flow of information to which it is exposed.  

Project 4G Didactic Pills intends to develop and disseminate a pedagogic method based 

on the theoretical foundation of the “Didactic Pill” focused on life skills in a practical and 

usable way, aiming to prevent and/or face the early school leaving. Through the proposed 

methodology, teachers will acquire new tools to promote reflections and experiences in 

secondary school students, including those with fewer opportunities and Special Education 

Needs (SEN) students, with a view to preventing their early school leaving. The use of the 

didactic pills methodology can be a starting point to understand how images, pictures and/or 

photos can help students to go into reflection, then act for change and become the best 

version of themselves.  
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The methodological approach of this project is based on micro-learning techniques 

(didactic pills) through images, videos, photos and short phrases combined with non-formal 

education and storytelling. This approaches help to understand and memorize, minimizing 

efforts and maximizing results.  

o 1.2. Didactic pill and storytelling 

The combination of traditional storytelling and the use of multimedia technology give 

as a result a powerful tool called “digital storytelling” that allows to significantly enhance the 

possibilities both in the creation of the stories and in their subsequent transmission1.   

Didactic pills are a learning method characterized by its brevity: they are tasks or 

proposal lasting no more than 20 minutes that, in addition, must be accessible from any device 

(computers, tablets or smartphones) and from an environment beyond the classroom.  

There is no single formula for micro-learning. Small content can be delivered in many 

different ways. Some examples are short videos, podcasts, audios, GIFs, board game 

questions, or event Twitter threads. So would a post on a social network or blog. Another “pill” 

format is the one offered by the TikTock social network, very popular among teenagers. Here 

several teachers are encouraged to teach “mini-classes” in videos of less than 60 seconds. 

Other forms include small anecdotes prepared by the teacher to explain a concept, learning 

cards, or even emails with content such as “tip of the day”. Mobile apps (such as instant 

messaging apps) and audio files can also be used to deliver short content. All of them have 

these characteristics and serve to apply micro-learning in class, which structures the content 

in these small doses that students can “chew”, work and learn actively and consciously. 

After the arrival of ICT in the classroom, storytelling has been implemented as a 

method to counter stories using emotions and technology. This technique increases 

motivation, active listening, creativity and trains students' digital skills. Storytelling uses 

traditional narrative techniques combined with multimedia elements (images, voice or music) 

 
1 Di Fuccio & Mastroberti, 2018; Nicolopoulou et al. 2015; Iandolo, 2011; Zancanaro et al., 2007; Baumer, 
Ferholt & Lecusay, 2005). 
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to build stories that connect with students through emotions. It helps to understand complex 

issues more easily, such as immigration. Thus, through a story starring, for example, an 

immigrant child, students internalize the problem and empathy is fostered. 

o 1.3. The use of images as a pedagogical tool to develop the emotional intelligence and 

soft skills 

Learning through images is a wonderful resource to receive information and remember 

it effectively since the brain is mainly a filer of images, rather than words. The part of the brain 

used to acquire new concepts is much smaller than the one in charge of processing images. 

The human brain has the ability to remember 70% of what we see, compared to 20% of what 

we read and 10% of what we hear. That is why we can see that students react quite well to 

visual content.  

This is because images have the power to cause sensations and emotions. At the same 

time, emotions are closely linked to learning. Francisco Mora, a neuroscientist, doctor and 

teacher, explains that “It is not about promoting emotions in the classroom, but about 

teaching with emotion, which means making what is taught curious. Curiosity arouses 

attention in those who listen and learn automatically and with this, it is obvious, they learn 

better. Nothing can be learned without alert, sustained, conscious attention. And nothing 

arouses attention more than what is made different and curious”2. 

Neuroeducation has proved that emotions can stimulate the activity of neural 

networks, reinforcing synaptic connections and consolidating learning in our brain in a better 

way. It should be clarified that emotions such as joy are related to an increase and 

improvement in the consolidation of learning. Thus, when the environment is positive in the 

classroom, the emotional brain receives external stimulus better. Consequently, knowledge is 

 
2 https://www.educaciontrespuntocero.com/entrevistas/francisco-mora-el-cerebro-solo-aprende-si-hay-
emocion/ 
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acquired more easily, and what has been learned is maintained over time. On the contrary, 

when learning is accompanied by emotions such as anger or fear, the effect is the opposite. 

At this stage, it is worth mentioning the concept of emotional education. According to 

Bisquerra and Pérez (University of Barcelona, 2012), "emotional education is a continuous and 

permanent educational process that aims to promote the development of emotional 

competencies as an essential element of human development, in order to train them for life 

and with the purpose of increasing personal and social well-being”3. Indeed, it contribute to 

the personal development, can prevent disorders such as anxiety and depression, and includes 

strategies to resolve conflicts. 

For all these reasons, emotional intelligence will give many advantages to students at an 

educational and personal level, because it will allow them to identify their feelings, control 

impulses, know how to manage them to make good decisions and foster a more positive and 

optimistic attitude. 

When we talk about soft skills, we refer to different qualities of emotional intelligence. 

They are personality traits, social skills, communication, language, personal habits, friendship 

and optimism that characterize relationships with other people, including common sense and 

a positive flexible attitude. 

It is vitally important to include them in education, for 3 main reasons:  

1. They constitute a form of prevention of other risk situations: aggressiveness, 

impulsiveness, abusive situations, behavioral problems, etc.  

2. They help students become well-rounded professionals. It is not only about providing 

them with knowledge, but about making them grow as people and helping them 

develop different qualities that must go hand in hand with their curricular growth. 

 
3 https://www.unibarcelona.com/es/actualidad/noticias/que-es-la-educacion-emocional 
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3. Hard skills (knowledge and experience) will be easier to assimilate when soft skills are 

developed. This has a direct impact on the motivation to study, and on the decrease in 

early school leaving. 

For these reasons, education in soft skills combined with the use of new technologies 

constitute a tool to generate opportunities and fight against early school leaving (ESL).  

o 1.4. Didactic work techniques with images.  

Through the image, teachers can work on soft skills and emotional intelligence with 

their students, achieving the following results:  

▪ Development of communication skills that encourage creativity and participation, and 

favour class dynamics.  

▪ Increased motivation due to its power of attraction.  

▪ Arouse curiosity and spontaneous and natural reactions, whether we like the image 

we see or not.  

▪ Interpersonal and intercultural relationships are worked on, by being able to transmit 

cultural content more directly: it would be complicated to explain only with words how 

Holy Week is celebrated, or what the atmosphere is like Christmas in the streets of the 

city. Pictures are especially helpful when we find ourselves in a teaching situation in 

which there are different cultures.  

▪ Development of self-awareness, management of emotions, empathy and critical spirit.  

▪ Provide a playful and entertaining character.  

 

To choose a suitable image, the first thing we have to take into account is making sure that 

it responds to the needs of the class and the didactic objectives. Also, the quality and size of 

the image are important, as it has to be attractive and motivating. Although not all images are 

valid to meet a specific objective, any of them is capable of provoking different topics of 

conversation. Sometimes it will happen that we are going to have to force the issue ourselves 
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to fulfil our educational objective. In these cases, we must create impulses through questions 

or comments to focus attention on what interests us.  

 

 There are several procedures that we can use to work with images. We want to 

highlight those we consider fundamental due to their great communicative value. These are 

the expansion and image manipulation. However, the image itself can be of great utility 

without having to resort to the typical exercises of describing what is in the picture:  

Image enlargement: it consists of seeing beyond what the image shows itself. There are four 

ways to enlarge the image:  

o Spatially: we observe the image by imagining what is around it. Observe the image:  

 

Describe what is on each side of the photograph. Is there anyone / anything else 

around?  
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o Temporarily: we assume what has happened before the moment that captures the 

image or what will happen next.  
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Why are they on the train tracks? 

Have they got married or have they run away from the wedding?  

Why is she barefoot? What happened to her?  

What are they going to do? Where are they going?  

o Socially: we deduce the social aspects of the image such as social class, personal 

relationships, the environment in which they live, etc. Who is he? Your lover, your 

husband, a friend, a relative? How and where did they meet?  

o Communicatively: we formulate hypotheses about what the people who appear in the 

image are talking about, how they feel and what they are trying to express through 

their gaze, posture, gestures, etc. What are they talking about? Are they happy or sad? 

Are they calm or worried?  

o Manipulating the image: just as texts are manipulated to order the paragraphs, 

complete them, look for errors, etc., the images also can be treated in the same way. 

We can cut the images into strips (for example a comic or drawings for them to put in 

order and then count the history); or go discovering the image little by little to make 

hypotheses on it and produce expectations, maintain the interest and attention, so 

that we create a more participatory and productive environment in the classroom.  
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Practical exercise: cut the image so that they put them in order and tell a story, talk 

about the characters, give their opinion on a topic, etc. 

o Interpreting or valuing the image itself: There are other ways of working with images, 

which imply neither manipulating them nor enlarging them. Sometimes, images 

already have great expressive value, for which it is worth working with them without 

altering them. Among this type of image, we highlight pictorial artworks, which in 

addition to offering important cultural content, have an emotive function as a 

transmitter of feelings and emotions. Lets not forget that art is subjective and people 

can come to have different concepts of what they consider “a work of art” or not. In 

this sense, students´ diversity of opinions about an image is itself a good reason to start 

an interesting discussion in the classroom. Painting belonging to different artistic 

currents can be brought to class so that the students make a comparison and give their 

opinion about them. Besides, through group discussions, debates, pedagogical games, 

simulations, role plays, storytelling, reflections, interactive quizzes, presentations, etc., 

the teacher can create a safe space for participants to explore, discuss, understand life 

skills, to experience the important role that teachers have in supporting students in 

achieving life skills and to create didactic pills. This pedagogical model proposes the 

use of images through technological devices, but it is up to teachers to define 

concretely which stories will be told so that students achieve the expected results.  
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o 1.5. Information and Communications technologies (ICT) combined with non – formal 

learning 

Information and communication technologies (ICT) are permeating our lives, changing 

our visions of the world and modifying patterns of access to knowledge and interpersonal 

interaction. Today, learning processes branch off, leaving conventional paths behind. The 

Internet and virtual platforms can provide a new space for the construction of the different 

skills required by education today, skills that find new learning scenarios in a limitless territory. 

For example, the fact of uploading a photo to Instagram posing a mathematical problem can 

provoke curiosity and awake the spirit to do it. In this sense, we must face ICT as if it were a 

challenge to understand the present. In essence, they are an opportunity to create new 

scenarios for collaboration and the social construction of knowledge. 

Progressively, ICTs have been incorporated into the curricular designs of all levels of 

formal and non-formal education.  

Non-formal learning is intentional but voluntary learning that takes place in a wide 

range of settings for which teaching / training and learning are not necessarily its sole or main 

activity. These settings and situations may be temporary, and the activities or courses that 

take place may be run by professional learning facilitators (such as teachers or youth coaches) 

or volunteers (such as youth leaders). The activities and courses are planned, but they are 

rarely structured by conventional rhythms or curricular subjects. They usually address specific 

target groups, but rarely document or assess learning outcomes or achievements in 

conventional visible ways. We invite you to treat this methodology as a tool to find inspiration, 

suggestions and ideas to help students in their personal and educational development.  

Indeed, ICTs demand the existence of a new configuration of the didactic and 

methodological process traditionally used in schools, where knowledge does not have to fall 

on the teacher and the role of the student is not that of a mere receiver of information (Riveros 

and Mendoza, 2008).  
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⮚ Chapter 2. Interactive tools for production of “didactic pills” usable on 

mobile devices 

This chapter of the Manual includes 6 sections. 

The first section is an introduction to online pedagogy and answers the question of why 

teachers should use interactive tools when preparing for the learning process and developing 

teaching materials. 

The second section offers a list of various interactive applications that are used to 

organize a learning process, to conduct online training, to develop teaching materials and 

lessons, to implement interactive communication between a teacher and students, to conduct 

competitions, exercises, exams, tests, games, etc. The list includes 70 interactive applications. 

The next four sections focus on four interactive applications selected by the authors of 

the Manual that can be used to create didactic materials for mobile devices with a specific 

purpose and use. 

The third section presents Kahoot - a tool for interactive and gamified online content. 

Kahoot! is a game-based learning platform, used as educational technology. Its learning 

games, also known as "kahoots", are user-generated multiple-choice quizzes that can be 

accessed via a web browser or the Kahoot! app. Kahoot! also includes trivia quizzes. 

https://kahoot.com/  

The fourth section presents Genially – a tool for interactive animated content. Genially is 

an online tool for creating all kinds of visual and interactive content quickly and easily, for 

individual or team use. This all-in-one software allows you to create presentations, 

infographics, gamification, interactive images and more interactive content. With the free 

plan (registration required) the user can use the main features, while with a premium plan the 

user can make the most of the tool. https://genial.ly/  

https://kahoot.com/
https://genial.ly/
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The fifth section presents Canva – a tool for online graphic design. Canva is a graphic 

design platform, used to create social media graphics, presentations, posters, documents, 

videos and other visual content. The app includes templates for users to use. The platform is 

free to use (registration required) and offers paid subscriptions such as Canva Pro and Canva 

for Enterprise for additional functionalities. https://www.canva.com/  

The sixth section presents Audacity - Interactive tool for storytelling podcasts.  Audacity 

is a free, open source, cross-platform audio editing software. The program is available for 

Windows, GNU/Linux, macOS and other Unix-based operating systems. In the fall of 1999, 

Dominic Mazzoni and Roger Danenberg initiated the project at Carnegie Mellon University. 

https://www.audacityteam.org/  

  

https://www.canva.com/
https://www.audacityteam.org/
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⮚ Section 1. Why the teachers should use interactive tools for production of 

learning materials? / Effective online pedagogy 

Today's children are growing up in a technology-rich environment, and we can't expect 

them to sit quietly at the desk and copy from the blackboard. Memorizing and reproducing a 

certain amount of information cannot arouse students' interest or make learning attractive. 

The dynamics of life, the introduction and advancement of information and 

communication technologies provide the opportunity to create and present educational 

content through various online platforms. They allow designing and developing content that 

is not only accessible and usable, but also has a responsive design. Created in this way, the 

materials make the educational process more engaging and enrich the student's experience. 

On the other hand, they allow us to design educational environments and situations that 

provide access to materials from different devices at any time and in any place and thus 

improve learning. 

The COVID-19 pandemic and periods of lockdown have given impetus to distance 

learning. 

In its historical development, e-learning has gone through various phases - from receiving 

materials by correspondence to virtual teaching. Different authors give their definitions for 

this type of learning as "content development through any electronic device, including the 

Internet, intranet, extranet, satellites, audio/video cassettes, interactive television and CD-

ROM" (Ballesteros and Palazon, 2002) . William Horton gives a brief working definition of e-

learning: "E-learning is the use of information and computer technology to create a learning 

experience" (Horton, 2006) . On the other hand, Khan (2001) in Boneu (2007) from a more 

pedagogical point of view maintains that e-learning should contain instructional, pedagogical, 

technological, interface, assessment, management (administrator), support and ethical design 

of use; in other words, it is a mix of resources, interactivity, support and structured learning 

activities . Gros (2011) considers that e-learning has gone through three different generations. 

The first generation focused on a material-based model and their adaptation to web formats. 
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The second generation is focused on the virtual classroom model, seeking the best learning 

environment. The third generation - on a flexible and collaborative model, where the student 

carries out his online learning together with his peers, through a learning community, giving 

special importance to the generation of specialized online content accessible from different 

devices, using technology as a basis for creating and accessing content.  

Interactive learning is a more hands-on, real-world process of imparting information in 

classrooms. When technology and educational projects communicate, there is a dynamic 

interdependence. These methodological and technological changes have their own level of 

impact - some of them profoundly change the practices and forms of learning. 

By using different learning technologies, teachers can gain information about how 

students interact with learning materials. In general, this information allows for the 

personalization of the educational action and the design of a learning environment in 

accordance with the needs, interests and forms of interaction of teachers and students. 

Traditional didactic methods and means are changing and new tools are being introduced 

for teaching and evaluating each student, the role of the Internet in supporting student 

learning is increasing. 

Online pedagogy refers to how teaching is practiced using the Internet and related tools. 

Online pedagogy became extremely necessary after the announcement of the coronavirus 

epidemic at the end of 2019. It was the only means of ensuring the education among the 

students of the partner countries and also throughout Europe. The start of online classes has 

accelerated the digitization and informatization of teaching, such as the use of applications 

such as Google Classroom, Google Meet, MS Teams, Zoom and other various virtual platforms 

that allow the learner to learn and acquire knowledge in an interactive mode. Before COVID-

19, online learning in most countries was only used as a supplement to face-to-face learning. 

In 2010, Bill Pelz, Professor of Psychology at Herkimer County Community College, stated 

(his) three principles of effective online pedagogy: 
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Principle 1: Let students do (most of) the work. The more "quality" time students spend 

engaged with content, the more of that content they learn. 

Principle 2: Interactivity is the heart and soul of effective asynchronous learning. 

Interactivity is what distinguishes an effective online course from a high-tech correspondence 

course. 

Principle 3: Strive for presence – social presence, cognitive presence or teaching presence.  

Critical to online pedagogy are factors such as student engagement, interest, related 

issues, and effectiveness, as well as feedback on how learning is perceived by students as it 

progresses. The basis of online pedagogy is the ability to: 

(a) Build Relationships and Community;  

(b) Incorporate Active Learning; 

(c) Leverage Learner Agency; 

(d) Embrace Mastery Learning;  

(e) Personalize the Learning Process.  

The application of interactive tools in education has important implications. 

Interactive tools are decision support tools involving calculation and dialogue phases until 

a stopping condition is met. They increase the engagement of the target audience by clicking, 

tapping, typing or taking some other action. 

Interactive tools enable interaction and feedback, creating an exceptional, personalized 

experience. This effect can increase student satisfaction. 

Benefits of using interactive learning materials 

1. Increased engagement 
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2. Sharpens critical thinking skills 

3. Opportunity to practice what has been learned 

4. Situations as close as possible to reality 

5. Cooperate and work in a team 

6. Willingness to learn 

There are lots of interactive training tools available. They come in a wide range of forms: 

● measuring tools and calculators 

● polls and quizzes 

● games 

● interactive infographics 

● interactive videos and live streaming 
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⮚ Section 2. List with Interactive tools 

 tool 
Type of didactic 

activities 
Introduction words for the 

application 
website 

1 ActivePresenter 

Lectures Includes all the tools needed to record 
screen, annotate, edit screencast 
videos and create interactive 
eLearning contents. 

https://atomisyste
ms.com/activepre
senter/  Tests 

2 Animoto Lectures 

Using Animoto, both you and your 
students can create and share video 
content with ease. Simply select a 
storyboard, drag and drop assets, 
adjust fonts, colours, music and more. 

https://www.anim
oto.com/ 

3 AnswerGarden 

Tests You can elicit brief answers from your 
students using Answer Garden. This 
app has a minimalistic design and 
simple management features that 
make it perfect for collecting 
feedback. 

https://www.ans
wergarden.com/ 

Competition 

Lectures 

4 Apester Didactic Games 

Apester is omnichannel digital 
experience platform for the visual 
generation. With Apester you can 
easily design, edit and share 
interactive experiences from surveys, 
interactive forms, quizzes, mobile 
landing pages, custom web stories and 
much more to effectively segment 
your audience and personalize your 
messaging. 

https://apester.co
m/ 

5 App-eLearn 

Lectures Helps to design, create and publish 
responsive content to any platfrom, 
the content building blocks to logically 
build content framework, assessment, 
tracking and reporting functions such 
as question randomisation and 
recording of student assessment 
results into a Learning Management 
System 

https://www.app-
elearn.com/ 

Classes 

Tests 

6 Buncee Lectures 
You can construct and share 
interactive classroom content and 

https://buncee.co
m/ 

https://atomisystems.com/activepresenter/
https://atomisystems.com/activepresenter/
https://atomisystems.com/activepresenter/
https://www.animoto.com/
https://www.animoto.com/
https://www.answergarden.com/
https://www.answergarden.com/
https://apester.com/
https://apester.com/
https://www.app-elearn.com/
https://www.app-elearn.com/
https://buncee.com/
https://buncee.com/
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multimedia presentations with 
Buncee. You can integrate content 
from a variety of sources to create 
eye-catching content that engages 
your students. 

7 Cambridgeone Didactic Games 

Language Learning management 
systsem based on the experice of one 
of the leading universities in langauge 
education, teaching and learning.  

https://www.cam
bridgeone.org/ho
me 

8 Camtasia 

Lectures 
Camtasia makes it simple to record 
and create professional-looking videos 
on Windows and Mac. It is video 
recorder, video editor and screen 
recorder - free 30 - days trial version. 
Registration needed (TechSmith 
account). Languages: English, French, 
German, Japanese, Spanish, and 
Portuguese 

https://www.tech
smith.com/video-
editor.html 

Classes 

9 Canva Lectures 

Canva is an graphic design platform, 
used to create social media graphics, 
presentations, posters, documents, 
videos and other visual content. The 
app includes templates for users to 
use. 
The platform is free to use 
(registration required) and offers paid 
subscriptions such as Canva Pro and 
Canva for Enterprise for additional 
functionalities.  

https://www.canv
a.com/ 

10 Classkick Lectures 

Classkick is a free app that shows you 
what your students are working on. In 
addition, it gives you a platform to 
provide high-quality, real-time 
feedback. 

https://www.class
kick.com/ 

11 Coursera lectures 

Coursera is an online education 
platform. 
Coursera offers individual courses, 
specialized courses, and degree 
programs that support on-demand 
video lectures, homework exercises, 
peer-reviewed assignments, and 
community discussion forums. 

https://www.cour
sera.org/ 

12 Crowdsignal Lectures 

https://www.techsmith.com/video-editor.html
https://www.techsmith.com/video-editor.html
https://www.techsmith.com/video-editor.html
https://www.canva.com/
https://www.canva.com/
https://www.classkick.com/
https://www.classkick.com/
https://www.coursera.org/
https://www.coursera.org/
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Tests Create and share flexible surveys, 
quizzes, polls and ratings using 
Crowdsignal. Once you’ve collected 
your answers you can easily export the 
data, so that you can start analysing it 
properly. 

https://crowdsign
al.com Didactic Games 

13 DIALPAD Lectures 

Dialpad is an AI-powered cloud 
communications platform that turns 
conversations into opportunities and 
helps teams make smart calls. 

https://www.dialp
ad.com/ 

14 Doodle tests 
Doodle is the fastest way to schedule 
or find the right time for anything. 

https://doodle.co
m 

15 Doodly Lectures 

Doodly is a whiteboard animation 
software. The software sports a Drag 
and Drop interface that makes it easy 
to make sketches. While there are 
several types of this software 
available, Doodly stands out because it 
is easy to use by even beginners. 

https://www.doo
dly.com/ 

16 Dugga Tests 
Dugga enables to create, schedule and 
grade exams seamlessly in one place. 

www.dugga.com 

17 EdApp 
Lectures Micro learning, gamification, spaced 

repetition and many other. 
https://www.edap
p.com/ Didactic Games 

18 EdCast Lectures 

EdCast is an AI-powered knowledge 
cloud for unified discovery, knowledge 
management, and personalized 
learning. 

https://www.edca
st.com/ 

19 EDPUZZLE Lectures 
Edpuzzle is a web-based tool for 
editing online videos and adding 
interactive content. 

https://edpuzzle.c
om/ 

20 
Explain 

Everything 

Team Group 
(case study) 

Explain Everything is a platform for 
engaging teaching and learning by 
recording tutorials, creating 
interactive presentations and 
assignments. 
It has a basic free plan (registration 
required) and there are several plans 
with additional features. 

https://explaineve
rything.com/ 

Lectures 

21 ForAllRubrics 
Lectures ForAllRubrics is a website where 

teachers can create rubrics, collect 
assignments, assess students, and give 

https://forallrubri
cs.com Didactic Games 

https://crowdsignal.com/
https://crowdsignal.com/
https://www.dialpad.com/
https://www.dialpad.com/
https://doodle.com/
https://doodle.com/
https://www.doodly.com/
https://www.doodly.com/
http://www.dugga.com/
https://www.edapp.com/
https://www.edapp.com/
https://www.edcast.com/
https://www.edcast.com/
https://edpuzzle.com/
https://edpuzzle.com/
https://explaineverything.com/
https://explaineverything.com/
https://forallrubrics.com/
https://forallrubrics.com/


 

 

 

 
 

Page 25 of 114 
This project has been funded with support from the European Commission. This publication reflects the views only of the authors, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 
 

feedback. Accounts are required to 
use the site, but it allows users to 
import classes from CSV or Excel files 
to cut down on the workload. 

22 Formative Lectures 

Formative will help you find, build and 
share digital formative assessments, 
tasks or assignments that can be 
accessed by your students on any 
device. Furthermore, you’ll see 
individual student responses in real 
time! 

https://formative.
com/ 

23 
Freehand - 

Whiteboard 
Lectures 

InVision Freehand is the digital 
collaborative whiteboard for all the 
work you do. Run brainstorms, project 
kickoffs, workshops, design sprints, 
and more. Make meetings interactive, 
engaging, and inclusive with the 
Freehand for Webex app.  

https://www.invisi
onapp.com/freeha
nd 

24 genially 

Lectures Genially is an online tool for creating 
all kinds of visual and interactive 
content quickly and easily, for 
individual or team use. This all-in-one 
software allows you to create 
presentations, infographics, 
gamification, interactive images and 
more interactive content. 
With the free plan (registration 
required) the user can use the main 
features, while with a premium plan 
the user can make the most of the 
tool. 
Languages: English, Spanish, 
Portuguese, French 

https://genial.ly/ 
Didactic Games 

25 Google Forms Tests 

Google Forms is a survey 
administration software included as 
part of the free, web-based Google 
Docs Editors suite offered by Google. 
The service also includes Google Docs, 
Google Sheets, Google Slides, Google 
Drawings, Google Sites, and Google 
Keep. Google Forms is only available 
as a web application. 

https://www.goog
le.com/forms 

https://formative.com/
https://formative.com/
https://genial.ly/
https://www.google.com/forms
https://www.google.com/forms
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26 
Google 

Jamboard 
Lectures 

With Google Jamboard, a user is able 
to create a 'Jam' where they are able 
to draw, create shapes, lines, and add 
text. The user can also choose 
between four pen types and six colors. 
There are also tools provided to erase 
and move objects, as well as create 
digital sticky notes, and turn their 
touchpoint into a digital laser pointer. 
For creating Jams a Google account is 
required, while users can enter the 
Jam without registering or signing in. 
Languages: English 

https://jamboard.
google.com/ 

27 H5P 

Lectures H5P makes it easy to create interactive 
content, such as interactive videos, 
interactive presentations, quizzes, 
interactive timelines and more, by 
providing a range of content types for 
various needs. 
The user can create interactive 
content by adding the H5P plugin to a 
WordPress, Moodle or Drupal site, or 
integrate it via LTI with Canvas, 
Brightspace, Blackboard and many 
other VLEs that supports LTI 
integration. 
H5P itself is open source and free open 
source plugins have been developed 
for various publishing systems 
allowing users to host the free code 
themselves. Those hosting H5P 
themselves will most likely be paying 
someone else for the hosting. 

https://h5p.org/ 

Tests 

Didactic Games 

28 Hypocampus Tests 
It's an evidence-based study tool for 
high-school students 

https://www.hypo
campus.se/ 

29 Involve.me Didactic Games 

No-code content builder for quizzes, 
surveys, calculators, forms & payment 
pages. Create personalized 
interactions at every step of the 
customer journey. 

https://www.invol
ve.me/ 

30 Ion Interactive Didactic Games 
Launch code-free quizzes, ROI 
calculators, assessments, interactive 

https://rockconte
nt.com/products/i
on/ 

https://jamboard.google.com/
https://jamboard.google.com/
https://h5p.org/
https://www.hypocampus.se/
https://www.hypocampus.se/
https://www.involve.me/
https://www.involve.me/
https://rockcontent.com/products/ion/
https://rockcontent.com/products/ion/
https://rockcontent.com/products/ion/
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infographics, and other interactive 
formats in just a few hours. 

31 isEazy 

Lectures more than 20 types of interactive 
elements to motivate students, 
pedagogical games, interactive video; 
FREE trial as long as you want  (with a 
watermark on the courses that are 
exported). 

https://www.iseaz
y.com/ 

Didactic Games 

Tests 

Classes 

32 iSpring 

Lectures free trial 30 days, iSpring Suite is a fast 
and user-friendly eLearning toolkit 
that builds into your PowerPoint. With 
iSpring Suite, you can easily create a 
course, record narration, put together 
a quiz, and publish the course online 

https://www.ispri
ngsolutions.com/ 

Classes 

Tests 

Team Group 
(case study) 

33 Jotform Tests 

Jotform is a full-featured online form 
builder  
that makes it easy to create robust  
forms and collect important data. 

https://www.jotfo
rm.com/ 

34 Kahoot! Competition 

a tool for interactive and gamified 
online content. Kahoot! is a game-
based learning platform, used as 
educational technology. Its learning 
games, also known as "kahoots", are 
user-generated multiple-choice 
quizzes that can be accessed via a web 
browser or the Kahoot! app. Kahoot! 
also includes trivia quizzes. 

https://kahoot.co
m/ 

35 Kaltura Classes 
Manage video, audio and image assets 
at scale. Cloud video transcoding and 
image manipulation 

https://corp.kaltur
a.com 

36 Kialo Edu Didactic Games 

Kialo Edu allows educators to curate 
spaces for students to work through 
complex subjects together, while 
giving students the space to ask 
questions, discuss, and evaluate new 
ideas. 

https://www.kialo
-edu.com/ 

37 Learnifier Classes 

This tool is usually used by companies 
to create learning outcomes. 
However, it could be useful for higher 
education students 

https://learnifier.c
om/ 

38 LearnUpon Lectures 
This  is cloud-based option intended 
for educational purposes, corporate 
training, customer education, and 

https://www.learn
upon.com/# 

https://www.iseazy.com/
https://www.iseazy.com/
https://www.ispringsolutions.com/
https://www.ispringsolutions.com/
https://www.jotform.com/
https://www.jotform.com/
https://corp.kaltura.com/
https://corp.kaltura.com/
https://www.kialo-edu.com/
https://www.kialo-edu.com/
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partner training. Among the strong 
eatures are its  functionalities, user-
friendly interface, and multilingual 
suppor. Its ability to segment different 
teams and create unique learning 
paths is one of the advantages it 
offers. 

39 MapMe 
Team Group 
(case study) 

Mapme is used to create interactive 
maps across all industries: non-profits, 
cities, real estate, construction, retail, 
and travel just to name a few. Mapme 
can handle endless use cases of digital 
maps. These are just a few: project 
portfolios, events, neighborhood 
guides, real estate listings, and 
locators. 

https://mapme.co
m/ 

40 Mentimeter 

Tests Mentimeter focuses on online 
collaboration for the education sector 
allowing students or public members 
to answer questions anonymously. 
The app enables users to share 
knowledge and real-time feedback on 
mobile with presentations, polls or 
brainstorming sessions in classes, 
meetings, gatherings, conferences and 
other group activities. 
The free plan (registration required) 
includes unlimited audience size (for 
quizzes it is up to 2,000 users), 
unlimited number of presentations, all 
question types, unlimited Content 
slides, maximum two Question slides 
and five Quiz competition slides per 
presentation. 
Languages: English, Spanish, 
Portuguese, Italian. 

https://www.men
timeter.com/ 

Competition 

Lectures 

41 Mirillis Action! Lectures 

screen recorder and streaming 
software is an ultimate tool for 
recording and live streaming of all 
desktop activity including tutorials 

https://mirillis.co
m/ 

42 MIRO Laboratories 
Miro is your team's visual platform to 
connect, collaborate, and create — 
together. 

https://miro.com/
it/ 

https://mapme.com/
https://mapme.com/
https://www.mentimeter.com/
https://www.mentimeter.com/
https://mirillis.com/
https://mirillis.com/
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43 Moodle Lectures 

Moodle is a free, online Learning 
Management system enabling 
educators to create their own private 
website filled with dynamic courses 
that extend learning, any time, 
anywhere. 
Whether you're a teacher, student or 
administrator, Moodle can meet your 
needs. Moodle's extremely 
customisable core comes with many 
standard features. Take a look at a 
highlight of Moodle's core features 
below and download the file Moodle 
features for students (pdf) comparing 
the LMS, Moodle app and offline 
features.  

https://moodle.or
g/ 

44 Moovly Lectures 
video production, create flipped 
classroom videos or engage students 
with video assignments. 

https://www.moo
vly.com/ 

45 Mural Lectures 

The MURAL App for Webex brings 
imagination to collaborative work by 
providing a shared digital canvas with 
complete native functionality for 
teams to innovate without leaving 
Webex. With communication and 
visual collaboration occurring in one 
space, teams find the right content 
quickly, stay aligned, and deepen 
engagement when solving hard 
problems, wherever the team is 
located. 

https://apphub.w
ebex.com/applicat
ions/mural-mural 

46 Outgrow Didactic Games 

Outgrow is a SaaS tool that you can 
use to create personalized content 
that helps you generate more 
qualified leads and better engage with 
your customers. You can build 
calculators, quizzes, ecommerce 
recommendations, assessments, polls 
etc.  

https://outgrow.c
o/ 

47 Padlet Lectures 

Padlet provides a cloud-based 
software-as-a-service, hosting a real-
time collaborative web platform in 
which users can upload, organize, and 

https://padlet.co
m/ 

https://www.moovly.com/
https://www.moovly.com/
https://apphub.webex.com/applications/mural-mural
https://apphub.webex.com/applications/mural-mural
https://apphub.webex.com/applications/mural-mural
https://outgrow.co/
https://outgrow.co/
https://padlet.com/
https://padlet.com/
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share content to virtual bulletin 
boards called "padlets". 

48 Panopto lectures 

Panopto is a secure video portal for 
your Webex Meetings recordings 
which allows users to share recordings 
with people who couldn’t attend the 
meeting and recall relevant moments 
from any meeting. 
Webex Meetings administrators get 
more control over recording 
permissions. Meeting hosts benefit 
from simplified sharing. Participants 
get a more interactive and engaging 
playback experience. 

https://www.pano
pto.com/ 

49 Playbuzz Tests 

Storytelling Tools Designed for 
Maximum User Engagement. Create 
an account and populate any one of 
our storytelling tools with your own 
content. Choose from polls, 
slideshows, video snaps, quizzes, lists, 
flip cards, countdowns and more. 

https://www.play
buzz.com/quizzes 

50 Quia 

Didactic Games Create your own educational games, 
quizzes, surveys, and web pages with 
Quia. Search millions of games and 
quizzes created by educators around 
the world. 

https://quia.com/ 
Lectures 

51 QUIZIZZ Didactic Games 

Quizizz is an educational software that 
creates and sells a gamified student 
engagement platform. The software is 
used in class, group assignments, pre-
test review, formative assessments 
and pop quizzes. 

https://quizizz.co
m/ 

52 Quizlet Live 
Team Group 
(case study) 

Quizlet is a collaborative game. 
Instead of students answering 
individual questions on their individual 
devices, Quizlet puts students in 
groups. All possible answers are 
divided amongst the devices of all 
students participating. 

quizlet.com/live 

53 Raptivity 
Didactic Games The game-based and quiz-based 

interactions have the right amount of 
fun elements to encourage knowledge 

https://www.rapti
vity.com/ Lectures 

https://www.playbuzz.com/quizzes
https://www.playbuzz.com/quizzes
https://quia.com/
https://quizizz.com/
https://quizizz.com/
http://quizlet.com/live
https://www.raptivity.com/
https://www.raptivity.com/
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retention, learning interactions for 
microlearning 

54 REMIND Lectures 

Remind is a platform for 
communication and learning that 
reaches students & parents. Built with 
mobile-first messaging that supports 
learning wherever it happens, Remind 
connects the people and resources 
that give every student the 
opportunity to succeed. 

https://www.remi
nd.com/ 

55 Schoology Lectures 

Schoology Learning is the leading K-
12-focused learning management 
system (LMS) that helps educators 
address unfinished learning, deliver 
personalized instruction that meets 
the needs of the whole child, and 
better prepare students for future 
success no matter where they are. 

https://www.scho
ology.com/ 

56 SEESAW Lectures 

Seesaw is at the heart of the learning 
process for millions of students. Our 
platform encourages creativity and 
feedback that makes students excited 
to learn.  Now more than ever, remote 
learning solutions are essential. 
Seesaw enables meaningful learning 
from anywhere, for every student. 

https://web.seesa
w.me/ 

57 Skillshare lectures 

Expand your horizons as you explore 
online classes from Skillshare. 
Discover new skills, techniques, and 
tools for a wide range of creative 
topics, from photography and graphic 
design, to drawing and animation. 
Whether you're a beginner or a 
master, a dabbler or a pro, you’ll be 
able to try free online classes with 
your Skillshare free trial to help you 
take your skills to the next level. 

www.skillshare.co
m 

58 Skolon AB  

It is a unique service for all the digital 
educational tools and make them 
work in the classroom. This platform 
brings together all of the teacher's 
digital tools and resources in one 
place. 

https://skolon.co
m/en/landing-
page/ 

https://www.remind.com/
https://www.remind.com/
https://web.seesaw.me/
https://web.seesaw.me/
http://www.skillshare.com/
http://www.skillshare.com/
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59 Slido Lectures 

Make your meetings more interactive 
with live polling and Q&A directly in 
Webex Meetings. Use live polls to get 
instant feedback, check for 
understanding or run inclusive 
decision making. Run a competitive 
quiz with a leaderboard for training 
purposes or just for fun. 
Give a voice to your audience and 
collect the most burning questions 
with live Q&A. 
Both presenters and attendees can 
interact directly in the sidebar without 
ever leaving Webex.  

https://www.sli.d
o/cisco-webex-
polling 

60 Socrative 

Team Group 
(case study) 

Socrative allows you to access free 
exercises and learning games that 
engage your students across all 
devices. Get instant feedback on 
learner progress and adjust your 
approach based on the results. 

https://socrative.c
om/ 

Lectures 

61 Stormboard 

Team Group 
(case study) 

Stormboard helps teams transform 
their meetings company-wide, no 
matter where employees are located, 
with shared sticky notes and 
whiteboards in an innovative digital 
workspace. 
Stormboard is free for educators 
(higher education included), by 
creating an education account using a 
valid school email address. 

https://stormboar
d.com/ 

Lectures 

62 StudyBee Tests 

StudyBee has assessment tools that 
enable teachers to assess student 
work directly in Google Classroom, 
and give feedback. So, it provides 
additional functionality to Google 
Classroom. 

https://www.stud
ybee.se/ 

63 SurveyAnyplace Tests 

Create your own online 
questionnaires with auto-generated 
personalized reports. Turn your 
expertise into a tool that delivers 
individualized advice at scale. 

https://surveyany
place.com/ 

https://www.sli.do/cisco-webex-polling
https://www.sli.do/cisco-webex-polling
https://www.sli.do/cisco-webex-polling
https://socrative.com/
https://socrative.com/
https://stormboard.com/
https://stormboard.com/
https://www.studybee.se/
https://www.studybee.se/
https://surveyanyplace.com/
https://surveyanyplace.com/
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64 SurveyMonkey Tests 

SurveyMonkey is a web-based 
program and hosting site that allows 
an individual to develop a survey for 
use over the internet. One of 
SurveyMonkey's features consists of 
creating high-quality, professional-
looking quizzes, including analysis 
tools that simplify the scoring of 
quizzes and help the user quickly 
interpret the results. 
The Basic plan is free (registration is 
required), there are several plans with 
additional features. 
Languages: English and several others. 

https://www.surv
eymonkey.com/?u
t_source=homepa
ge&ut_source3=h
eader 

65 Synthesia Lectures 
video production, includes templates, 
a screen recorder 

https://www.synt
hesia.io/ 

66 Thinglink Lectures 

ThingLink can be used to radically 
improve engagement and learning 
results with interactive media: images, 
videos, virtual tours, 3D models and 
simulations. 

https://www.thing
link.com/ 

67 Think Exam Tests 

an exceptional platform for 
conducting online exams, a smooth 
platform to use and enhances the flow 
of information. 

https://www.think
exam.com/ 

68 Uptale 

Lectures Uptale has one mission: to bring 
teachers and learners closer together 
through Augmented (A-)Learning. 
With Uptale, the eyes, ears, and hands 
of the teacher are captured with new 
types of cameras and motion sensors. 
The teacher can digitize his 
knowledge, skills, and behaviors to 
produce impactful A-learning 
experiences. These experiences are 
then efficiently proposed to the 
learner who can practice them with all 
his senses. We are working to bring A-
learning to all the people and 
organizations who have the ambition 
to thrive in the augmented world. 
Here you are! And it is just the 
beginning. 

https://www.upta
le.io/ 

Classes 

Didactic Games 

https://www.surveymonkey.com/?ut_source=homepage&ut_source3=header
https://www.surveymonkey.com/?ut_source=homepage&ut_source3=header
https://www.surveymonkey.com/?ut_source=homepage&ut_source3=header
https://www.surveymonkey.com/?ut_source=homepage&ut_source3=header
https://www.surveymonkey.com/?ut_source=homepage&ut_source3=header
https://www.synthesia.io/
https://www.synthesia.io/
https://www.thinkexam.com/
https://www.thinkexam.com/
https://www.uptale.io/
https://www.uptale.io/
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69 VISME Lectures 

all-in-one platform for creating 
Presentations, Documents,Data 
Visualizations, Videos and other 
branded content. 

https://visme.co/ 

70 Zoom Classes 

Zoom, stylized as zoom or Zoom 
Meetings is a proprietary 
videotelephony software program 
developed by Zoom Video 
Communications. The free plan allows 
up to 100 concurrent participants, 
with a 40-minute time restriction. 
Users have the option to upgrade by 
subscribing to a paid plan. 

https://zoom.us/ 

 

  

https://visme.co/
https://zoom.us/
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⮚ Section 3. Tool for interactive and gamified online content. Kahoot 

Kahoot is a game-based digital learning platform used by millions of people around the 

world every day. It uses quiz-style games that makes it easy to create, share and play learning 

games or trivia quizzes in minutes.  

At school, Kahoot can be used for any subject, any age, and with any device - students 

don’t even need to register for an account. You can use Kahoot both when teaching in class, 

for distance learning and in a blended learning format. 

Millions of teachers use Kahoot to… 

✔ Introduce new topics 

✔ Give the students a chance to feel motivated to keep learning 

✔ Review content at class and home 

✔ Engage their class via distance learning and/or with interactive lessons 

✔ Run formative assessment 

✔ Collect student opinions through an instant feedback 

✔ Foster creativity and teamwork 

✔ Track learning progress over time for formative assessments 

The software allows to create fun and quick learning games from scratch called “kahoots”. 

The format and number of questions is up to the creator that can add videos, images, and 

diagrams in order to amplify engagement. 

Kahoots, ideal for both hybrid and distance learning use, are usually best played in group 

settings and you need a unique PIN to join any game. For the game host, it is recommended 

to use a big screen. 

To create a kahoot, you can follow the following steps: 

1. Go to www.kahoot.com and log in (or sign up) as a teacher 

http://www.kahoot.com/
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Specify whether you work in a school, a higher education institution, or in school 

administration. Then choose a plan: you can use Kahoot! for free, or upgrade to one of our 

premium plans to unlock additional features. You can decide to upgrade at any time! (This 

tutorial only covers the free version of Kahoot) 

 

2. Click the “Create” button on top of the page to start creating your Kahoot 

 

 

3. Pick the game type that best suits you 
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Your options are:  

⮚ A quiz with multiple choice questions, in which the participants are supposed to 

pick the correct anwer to your question. A Kahoot quiz can be a great way to check 

students' knowledge before you start teaching a subject to help avoid making it 

too simplistic or too complicated for the class. 

⮚ A jumble, in which the students will need to put the answers in the right order 

⮚ A discussion, that allows you to ask one question and to start a debate out of it 

(without points) 

⮚ A survey, which is essentially a poll without points to gather opinions 

4. Customize your kahoot 

Start customizing the question and the answer alternatives, adding images (by uploading 

them from your computer or by choosing one from the online library), and/or embedding a 

YouTube link to the question.  
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You also have the possibility to adjust game options - for example, randomize the order 

of questions, or enable our friendly nickname generator to avoid inappropriate nicknames.  

Finally, you can choose whether students play individually (Classic mode) or in Team 

mode. 

Remember that instead of typing questions from scratch, you can add them from the 

website’s question bank – accessible from the left-hand side of the kahoot creator. That will 

help you create kahoots way faster. 



 

 

 

 
 

Page 39 of 114 
This project has been funded with support from the European Commission. This publication reflects the views only of the authors, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 
 

 

 

 

 

 

 

 

 

 

By default, questions are displayed on a shared screen, while students tap answer tiles on 

their devices. If you’d like students to see questions and answer alternatives on their devices 

(for example, if you have a large classroom or students are joining remotely), toggle this 

setting on: Show question and answers on players’ devices. 

A unique Game PIN will be displayed at the top of the screen. Students enter this PIN to 

join the live kahoot in the Kahoot! app or at kahoot.it in their browser. 

Click Start once you can see all the players’ nicknames in the “lobby”. During playing you 

can use the spacebar or your mouse to go to the next question. 

After the kahoot, you can always find and assess results in the Reports section. 

5. The kahoot is ready to be played 

Once your kahoot is set up, it is part of your collection of kahoots and you can choose 

whether to test it, to play it, or to share it with other people. If you click play, you can dedice 
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whether it is going to be immediately synchronous (then you click “teach”) or asynchronous 

(then you click “assign”). 

 

You can have up to 50 players and choose between the “classic mode” or the “team 

mode”. 

6. After the game is over – assessing learning results 

Once you have hosted a game, you can access the “reports” tab in the top navigation bar, 

that will show you: 

⮚ All the key stats (how many students played, how many questions there were, 

etc.) 

⮚ Which questions were the most difficult and might need reteaching 

⮚ Which players need help based on their game results 

⮚ All the past games that were played (including anonymous surveys) 
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This section thus allows you to assess learning results and better target your further 

instruction by capturing useful instructional insights for formative assessment.  

 

 

 

In the “Questions” view you can identify where exactly key challenges occur. Be sure to 

look at the correct overall percentage of the question and at how long it took (in seconds) for 

students to answer. 

In the “Players” view you can check which student (via their nickname) is answering 

incorrectly and how long are they taking to answer.  

If less than 35% of students answered a question correctly, that question is labelled as 

“difficult”. If there were 3 or more difficult questions in the game you hosted, you can 

generate a new one with them to reinforce learning power up content review and prep for 

exams. 
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USEFUL TIPS 

If you log in to your Kahoot account and navigate to “Discover” from the top bar, you can 

access millions of pre-set kahoots, many of which are high-quality ones. For example, you can 

have a look at collections such as the “Academy Verified educators” one, the “Academy 

Premium partners” one or the “Top picks” one.  

If you’re looking for something specific, get started by typing a keyword or phrase into 

the search bar at the top of the Discover section. The system will suggest popular kahoots that 

fit your search terms, but if you want to dig deeper, you can filter by Subject, Grade Level, and 

other filters. When you find a kahoot you like, you can play it right away, star it to add to your 

Favorites, or duplicate it to be able to customize it later. 

 



 

 

 

 
 

Page 43 of 114 
This project has been funded with support from the European Commission. This publication reflects the views only of the authors, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 
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⮚ Section 4. Tool for interactive animated content. Genially 

What is Genially? 

Genially is an online and freemium platform for the creation of animated and interactive 

digital content. it has an Edu version. It is in fact a tool that lends itself to being used in 

education, in order to facilitate the teaching-learning process both in presence and at a 

distance. 

The very simple and intuitive user interface, the possibility of realising without too much 

difficulty, using pre-set templates, a wide range of products with great visual impact, the 

multimedia nature of the creations, which can incorporate content of various kinds (text, 

images, audio, video), the possibility of sharing one's work with others and working together 

on the same project are all characteristics that make Genially a valuable ally for teachers. 

What can be achieved with Genially? 

As mentioned above, with Genially it is possible to create a wide variety of content in 

response to multiple needs.  

● Presentations  

Genially offers the possibility of creating presentations or video presentations that can 

be used by teachers, for the introduction of new topics (also in flipped classroom 

mode), or by pupils, as support for the presentation of their own in-depth research or 

group work.  

● Explaining from an image 

Genially allows us to let images speak for themselves. By creating an interactive image 

we can in fact enrich our images with other layers of information (video, audio, text, 

etc.). This allows teachers to launch new topics from a visual stimulus (a painting, a 

photograph, a map, etc.), but also allows children to demonstrate what they have 

learnt or, more generally, to express themselves using a creative mode of expression. 

● Schematising 
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With Genially, it is then possible to create infographics to schematise the topics 

explained or studied, translating them into an accessible and inclusive visual language. 

● Illustrate topics, practices and procedures 

Genially provides the possibility of constructing guides, i.e. interactive information 

documents that neatly bring together the information needed for initial understanding 

or practical guidance on a study topic, practice or procedure. 

● Learning by playing 

Therefore, Genially allows us to create games and quizzes to motivate pupils, actively 

involve them in the teaching-learning process, assess and promote the memorisation 

of concepts through fun. 

● Creating learning modules 

Finally, Genially allows us to create training materials that are true learning modules 

in which learning units are combined with challenges. 

How to register? 

To start using Genially, you must first register. 

You therefore need to go to the home page (https://genial.ly) and click on the 'Start 

now. It's free!' button.  
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You can choose whether to register with your Google, Facebook, Office 365, Twitter or 

Linkedin account, or with your e-mail. In the latter case, you will be asked to enter your full 

name, your e-mail address and the password you want to use.  

Once you have carefully read and accepted the terms of use and privacy policy, you 

can proceed by clicking on the 'Sign up' button. 

 

You will then be asked some questions about how you would like to use the platform 

that will allow Genially to personalise your experience. 

You can then log in with your email and password or with your Google, Office362, 

Facebook, Twitter or LinkedIn account. 

When you log in for the first time, you will be sent an e-mail to verify your account. 

How to start creating? 

Once you have completed your registration and verified your account, you are ready 

to begin your experience with Genially. All you have to do is access the dashboard, where you 

will find all the tools you need to be able to realise your creations. 

To start a new project, click on 'Create genially' button (In the Panel you will find it 

both in the menu on the left and in the centre of the page) and choose the type of content 

you want to create from the options offered. 
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You will then see a series of templates from which you can choose the one that best 

suits your specific needs. To speed up the search process and find what you need more quickly, 

you can filter the templates using the search engine. 
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If you do not find a template here that satisfies you, you can look for inspiration in the 

Genially Community. In the menu on the left-hand side of the Panel, click on the 'Inspiration' 

section. You will access the rich repertoire of creations made by other users in the community. 

You can use the search bar to find what you need more easily or filter the results to quickly 

find reusable geniallys. 

 

If you prefer not to use a pre-set template, you can choose to create your content from 

a blank page. In this case, after clicking on 'Create genially', select 'Blank creation'. You will be 

faced with a blank slate that will allow you to give full rein to your creativity. 

Finally, Genially offers the possibility of working on a PowerPoint document, modifying 

its content and graphics and adding animations and interactive elements. If you want to use 

this function of Genially to breathe new life into your old presentations, all you have to do is 

click on 'Create genially', select 'Presentations' and then click on 'Import PPT'. You can import 

a file in .pptx format as long as it does not exceed 100 Mb and start working on it. 

After selecting the template, it will open in the Editor. To return to the Panel, click on 

the Genially icon in the top left corner.  
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The Panel is the place where you can view the thumbnails of your creations. To make 

changes to a creation, hover over its thumbnail and click on the ‘Edit’ button. 

 

How to assign a title to a genially? 

To attribute a title to your genially you have two options.  

From the Editor, all you have to do is enter the title in the text box on the top bar. The 

changes will be saved automatically after a few seconds. To speed up the saving process, you 

can click on the little cloud icon. 
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From the panel, you must instead hover over the project thumbnail, click on the three 

dots that appear in the top right-hand corner and then select the 'Rename' option. 

 

How to collaborate with others on the same project? 

Genially gives us the opportunity to work as a team and realise group creations.  

Once you have created a project, you can decide to avail yourself of one or more 

collaborators to complete it. All collaborators will see the project in the 'Creations' section of 

their Panel and will have the possibility, one at a time, to make changes to it.  

How to add collaborators? You can do this from the Editor or from the Panel. From the 

Editor, click on the collaboration icon located to the right on the top bar. 
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From the Panel, hover over the thumbnail of the genially you want to make 

collaborative and click on the collaboration icon.  

 

In both cases you will display a window where you will be allowed to enter the e-mail 

address of the person you wish to add as a collaborator. If you wish to add several 

collaborators, separate the different e-mail addresses with a comma. 
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What tools and functions do you have at your disposal? 

Once you have created your genially and assigned it a title, you can start customising 

your creation. A number of tools and functions are available to you to do this. 

Two menus are available in the Genially editor: a Main Menu and a Contextual Menu. 

● Main Menu 

This menu, located within the sidebar on the left, provides the various resources that 

can be included in the creation by grouping them by type. Some of them are not 

available in the free version. To incorporate a resource within the creation, simply 

select it and drag it to the desired position with the mouse (drag and drop system). 

 

 

- Text  
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In this section you have various text boxes in different formats and a number of style 

sets that you can insert into your creation. 

- Image 

Clicking on this section gives you several possibilities to insert images into your 

genially. You can choose from those provided by the platform, upload them from your 

device, Google Drive or Dropbox, or you can search for them on Pixabay or Giphy. 

Genially.ly gives you the opportunity to save space on your hard disk: by pasting the 

URL on your image you can embed it in your creation without having to download it. 

- Resources  

This section gathers a wide variety of elements (icons, shapes, charts, lines, arrows, 

illustrations, scenes, maps or silhouettes) with which you can enrich your project. 

- Interactive elements  

This section gathers a series of elements (such as buttons, markers or icons) that you 

can include in your creation and provide with interactivity. 

- Smartblocks  

This section gives access to a large repertoire of smartblocks, i.e. sets of predefined 

elements with a variety of themes that will help you easily complete your creation. 

- Insert  

From this section, you can insert audio, video or other multimedia content into your 

creation. Various options are offered. Resources can be, for example, uploaded from 

your own device, from Google Drive or Dropbox, or via links. 

- Background  

From this section, you can customise the basic background and page background of 

your creation. You can choose a plain background by customising its colour, select a 

background from the Genially library or upload an external image. 

- Pages  

From this section, you can edit and manage the pages that make up your creation. 

Pages can be added, deleted, duplicated, hidden or password-protected. By clicking on 
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the magic wand at the top right of each page, you can open a menu that allows you to 

set the canvas size, transitions from one page to another and the navigation mode. 

● Contextual Menu  

This menu, which is opened by clicking on any element of the creation, includes a series 

of functions that allow you to act on the selected element by locking it, inserting an 

interaction, adding an animation or replacing the element itself.  

 

 

 

- Lock  

This function allows you to lock the selected element should you wish to modify the 

rest of the creation without running the risk of modifying it or changing its position by 

mistake. 

- Add interactivity 

This function allows you to equip the selected element with interactivity. There are 

seven types of interactivity that can be configured. 
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▪ ToolTip: when the mouse hovers over the selected element, other elements (text, 

images, videos, links, tables, etc.) appear on the screen. 

▪ Windows: clicking on the interactive element opens a window with text, images, 

videos or other content. 

▪ Go To Page: clicking on the interactive element automatically switches to another page 

in the creation. 

▪ Link: clicking on the interactive element opens a web page. 

▪ Full Screen: clicking on the interactive element expands it to fill the entire screen. 

▪ Audio: clicking on the interactive element starts an audio. 

▪ Reveal: clicking on the interactive element displays previously hidden content on the 

screen. 

- Edit animation 

This function allows the selected element to be brought to life with one or more 

animations. 
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How to publish your creations? 

As you proceed with editing your creation, Genially saves your progress automatically. 

Once you have finished your work, you are ready to publish it. You can choose whether you 

want it to be public, i.e., visible to anyone, indexed in search engines, or private, i.e., visible 

only to people with whom you share the display link. This second option is only available to 

those who purchase the Premium version. 

You can publish your genially from the Editor or from the Panel. If you are in the Editor, 

click on the 'All set!' button at the top right.  

 

If you are in the Panel, hover your mouse over the thumbnail of the presentation you 

want to publish, click on the three dots at the top right of the thumbnail, and then click on 

'Publish'.  
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Choose the publishing mode and then click on 'All set!'. Your genially is now ready to 

be shared or downloaded. 

 

How to share or download your creations? 

Once you have published your creation, you can share it with whoever you want. Go to 

the Panel. Hover over the thumbnail of your creation and you will see the share icon. Click 

on the icon. You will have several options: 

● Link sharing 
● Embedding in a website or blog via Iframe script 
● Sending by e-mail 
● Sharing on social media 
● Sharing on Google Classroom 
● Sharing on Microsoft Teams 
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After publication, if you have purchased the Premium version, you also have the option 

of downloading your creation. Once again, you will have to hover over the thumbnail of the 

genially you want to download. This time click on the download icon. You will be able to 

choose in which format you want to download your work: 

● PDF 

● JPG 

● HTML 

● MP4 

 

What if you have doubts?  
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Using Genially, thanks to its user-friendly interface and drag and drop system, is very 

easy and intuitive. In any case, the guide provided by the platform can be consulted to clarify 

any doubts.  

When you are in the Editor, click on the 'Help' button at the bottom right and look 

for answers to your questions. 

 

You can also search for Genially support to solve your difficulties by clicking on the 

question mark at the bottom of the Main Menu. 
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⮚ Section 5. Tool for online graphic design. Canva 

Canva is an online tool for making graphics. It is free (but also has a paid pro version) and 

is very convenient for making simple graphics. Canva is very useful especially for users 

unfamiliar with graphics, and it is used a lot in web and social graphics. 

 

Canva is an online graphic design software that was created to allow anyone, 
regardless of their design skills and experience, to create professional-looking visuals with 
ease. 

The tool is designed to be as beginner-friendly as possible, so you should have no 
problems learning how to use it. 

With Canva you can create a huge range of designs including posters, logos, videos, 
social media content, printables, banners, websites, and so much more. 

Essentially Canva is the ultimate tool for creating high-quality designs and marketing 
assets quickly and easily. 

What you can create with CANVA for images for your social media  

- Facebook posts and covers 

- Create posts on Instagram 
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- Create an Instagram story, WhatsApp status and Facebook story 

- Twitter posts and headers 

- YouTube channel covers and thumbnails 

Graphics for your organization: 

- Create invitations 

- Card maker 

- Poster maker 

- Logo maker 

- Flyer maker 

- Blog banner maker 

- Create email headers 

- Photo collage 

1. Create an Account 

Check your inbox for a welcome email from Canva. Accept the invitation, and launch Canva in 

your web browser. (https://www.canva.com/). 

 

2. Starting a design 

To start off a design you can choose between two methods. Either you can start from a blank 

canvas or a simply choose a predesigned template as the starting point for your design. 

https://www.canva.com/
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To start from a blank canvas simply click on the ‘Create a design’ button and select a 

default size (e.g. Instagram story, poster, YouTube thumbnail, etc.) or click on ‘Custom size’ 

and put in the dimensions you want if you have something specific in mind: 

 

One good method of finding free templates on Canva is to choose a specific design size 

e.g. ‘Facebook post’, go to the editor with a blank canvas, and then select a template from the 

side panel. The templates with a crown icon are the ones only available to Canva Pro users, 

and the ones without a crown icon are free to use for all users: 
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3. Canva Editor 

 

1. Elements: Select photos, frames, shapes, lines, etc. to add to your design.  

2. Text tab: Beyond the text placeholders already available to you, the text tab gives you 

options to add additional pre-formatted text heads, sub-headings, and body text. There are 

also font combinations available  

3. Uploads tab: This area allows you to upload your own elements such as images and graphics.  
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5. Folder: All of your designs, favorites, purchases, items shared with you, and folders are 

available here.  

6. Home: Takes you back to your home page.  

7. File: Create a new design, show margins, show print bleed, save all your changes, move to 

folder, resolve comments, see version history, make a copy, download your design, or look for 

help. 

8. Resize: Allows you to change the size of your design.  

9. All changes safe: While Canva automatically saves your changes, much like Google Docs and 

Slides, this feature gives you an opportunity to ensure your changes were saved before closing 

out of the platform. 

10. Document name: Allows you to change the naming convention of your design at any time. 

11. Share: Allows you to share your design with others. This feature also gives you the 

flexibility to adjust restrictions, allowing individuals to view or edit.  

12. Download: This feature gives you different options and formats to download your design 

in.  

13. Publish: Download your design, share a link, make a presentation, email the design, or 

share it on social media.  

14. Add notes: Add notes to your design.  

15. Page controls: If you have more than one page, use this area to navigate between them. 

You also have the ability to copy them and delete them.  

16. Add a new page: Directly add new pages with this button.  

17. Zoom Control: Make your work area larger or smaller.  

18. Help: Access and use Canva’s support functionality, while still working on your design. 
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2. Elements  

Canva has an incredible amount of design elements that you can use. We’ll only cover the 

most widely used ones in this guide including graphics, shapes, and photo frames but there is 

an almost endless amount for you to choose from. 

Here you’ll find photos, grids, frames, shapes, lines, illustrations, icons, charts, and more. To 

select an element:  

 

1. Click on the elements tab.  

2. Select a category you want to browse in.  

3. Then drag and drop the element into the design area. 

3. Grids  
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Used to hold images. Select the right grid depending on the numbers of images you plan to 

use. You should also select the grid layout that works for you e.g. for two images laid 

horizontally, The frames and Grid elements are shapes in which you can add images too. They 

offer a really quick to create interesting and unique designs. 

To use these, all you need to do is add one to your page, then go to the photos tab, find a 

photo that works for you and drag it over the frame or grid and the image when then appear 

inside it: 

 
Other elements includes: 

o Graphs and charts 

o Tables 

o Stickers (animated elements) 

o Gradients 

o And much more. 
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If you find some elements that you really like the style of, you can view the artist who 

created that element by clicking on the three dots on a particular element which will bring 

up more information including the author name. 

Clicking on their name will take you to more elements that they’ve designed and added to 

Canva. 

You can also click ‘Star’ and this will add an element to your ‘Starred’ folder. So you can go 

back to that folder at a later date and easily find all of your favourite design elements: 

 

4. Graphics  

Some of the graphics that you add to your design will allow you to alter the colors, whilst 
with other graphic elements you might not have that option. 

To get around this you can go to ‘Edit image’ and select the Duotone or ColorMix options to 
alter the colors of these elements: 
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5. Photos 

Canva has a huge library of stock photos that you can utilize for your designs. Many of which 

are free to use for free Canva users. 

You can put in a search term to find specific, and Canva also has some theme suggestions as 

well as trending photos to help you find the photos that you’re looking for: 

You can click on a photo to add it to your design, or drag it onto the canvas so the image 

becomes the background for your selected page: 
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To add effects to a photo click on ‘Edit image’ and you’ll see various options on the left side of 

the editor such as ‘Adjust’ which allows you to edit the brightness, contrast, saturation, and a 

few other adjustments to the image. 

6. Uploads  

If you have your own images, videos, or audio that you want to upload to Canva you can add 

them to your uploads area. You can even upload files directly from other platforms including 

Dropbox, Facebook, Instagram, Google Drive, and Google photos: 
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⮚ Section 6. Interactive tool for storytelling podcasts. Audacity 

6.1. Storytelling 

Humanity is driven by stories and this is nothing new since the first drawings in caves 

in Prehistory. The survival of the human species depends on their ability to organise 

experiences, attributing meanings to what they have gone through and making a record of 

its point of view. 

More than documenting for the sake of documenting, the stories we know today 

have remained in the memory of humanity due to their relevance, for presenting a cohesive 

narrative that dialogues with our reality. 

In this sense, storytelling emerges as the practice or technique of presenting a good 

story, so that it has a beginning, middle and end. The proposed narrative should be one 

capable of captivating the listener, holding his attention until the end. Besides, it needs to be 

memorable, remaining in the memory for a long time and in a meaningful way. 

How to do storytelling? 

Several factors make up a successful narrative. Firstly, we need to keep in mind who 

our target audience is, and from there select the message to be communicated and the 

language to be used. 

So, we can divide the concept between the "story" - the message itself - and the 

"telling" - which concerns the structure of the narrative. 

There is no point in having a powerful story to tell if we are not able to organize a 

narrative that has an impact and is able to move those who listen. 

Within the structure of the story, we must also consider the basic principles, which 

are: the message, the environment, the characters and the conflict. 
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As much as there are techniques to structure a story in an engaging way, the 

elements of storytelling should reflect our audience for a captivating and assertive 

communication. 

What is the importance of Storytelling? 

When we communicate, we want to hold the audience's attention until the end to 

make sure we have passed on our message effectively. 

However, with the popularisation of mass media, it is becoming increasingly difficult 

to capture the viewer's attention. 

Dispersion is caused by this giant flow of information, making it difficult for those 

who want to get their point across, publicise a product or service and even tell their own 

story. 

The solution to this information "congestion" comes from prose and gives us clues 

about how humanity has been telling its story over the centuries. 

What are the main elements of Storytelling? 

While there is no recipe for good storytelling, there are four elements that are always 

present: 

a) Mensagem 

It is common for us to separate storytelling into two parts: 

• story: the story and the message to be conveyed; 

• telling: the way this message is presented. 

If the message is strong, it is possible that it has an effect even with a weak telling. 

But if it is weak, we can hardly save its content with techniques to tell it. 

The idea transmitted is what can transform and mark people's lives. 
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There are plenty of texts, stories and lectures that get the audience excited 

momentarily, but contents that really make a difference and make us remember them 

continuously are scarce. 

These are the ones that manage to reconcile the two sides of storytelling, by working 

well the following three elements with the message. 

b) Environment / Place 

Simply because events need to happen somewhere, having it well described makes it 

easier for the audience to embark on the journey. 

c) Character 

The character is the one who goes through the whole journey/story and undergoes a 

transformation that leads to the transmission of the message. 

But to go through that transformation, he/she must overcome the next element: 

d) Conflict 

The main factor that makes the audience interested in the story is the conflict: the 

challenge that arises for the character in order to motivate him/her to go through the whole 

journey. 

A very simple conflict does not arouse interest, because it does not generate 

identification. After all, very easy conquests are not usually valued. 

It must be more elaborated and also cannot be easily overcome. In this case, we 

would have a romanticized story, which may even arouse emotions, but hardly generates 

identification. 

Therefore, the conflict must be elaborated and difficult to overcome, to the point of 

requiring the transformation of the character to successfully overcome it.  
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6.2. Podcasts 

The podcast is a material delivered in the form of audio, very similar to a radio 

broadcast. The difference is that it is available for the consumer to listen whenever he/she 

wants, it is not a live program. 

We can say that the podcasts are based on the concept of audio marketing, 

representing a good opportunity for communication, with the proposal to bring more 

information, educate the public, and produce materials that are creative and entertain the 

public in audio format. 

The podcasts are very good for those who have an intense routine, because it is 

possible to listen to it at any time of the day, very different from videos and texts, in which it 

is necessary to stop for a while and focus attention only on the material. 

How to create a podcast? 

Here is a quick and thorough step-by-step to make it clear how much time and 

resources you need to invest in creating a good podcast. Check out the steps below! 

a) Planning  

It is no longer news to anyone that any action we want to take requires a minimum of 

planning. So, it is essential that this step is not neglected. It is in the planning that you 

establish the goal you want to achieve with the podcast. 

Generally, the idea is to build consumer loyalty and gain more and more audience, so 

it is necessary to pay special attention so that this planning helps this achievement. 

Also, before you go into action and record, you need to look at some elements that 

are important for the podcast and apply that planning. They are: 

• audience to be reached 
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• how to differentiate yourself from the competition 

• how to make the theme interesting 

• within the theme, what will be the content 

• how to create "images" with audio marketing 

• interval time between new episodes, keeping a good frequency 

• CTAs  throughout the podcast4 

• creation of a script (an example: beginning, CTA, middle, CTA, closing, etc) 

• training to understand the flaws in this planning. 

 

b) Recording 

Without any doubt, the recording is one of the most awaited moments, it is the time 

when the planning is put into action and the production of the podcast actually starts. It is 

important that it is recorded in a room with good acoustics and comfort for the participants. 

This way, the audio will come out with much higher quality and the participants will 

be comfortable to give their best. Be aware that the acoustics of the recording location is 

more important than the power of the microphone, for example. 

You need to pay attention to the acoustic isolation and the generation of noise during 

the recording. After that, it is possible to record the podcast in some software available in 

the market for this purpose. One example is Audacity. 

c) Editing 

As the podcast is not a live program, it must be edited. 

 
41 A podcast call to action, or CTA, is a request for listeners to do something. It could be something like requesting they visit your official 

website, buy some merch, write a review on iTunes, or just tell their friends about the show. 
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Then comes the time for editing, which is essential to give the necessary fluidity to 

the episode produced. First of all, make sure there is a backup of the original recording to 

avoid possible problems with the loss of the file or a wrong edition. 

Depending on the software used, it is possible to apply some techniques that help to 

ensure more quality to the podcast: sound amplification, noise reduction, compression, 

audio normalization and equalization. 

d) d) Publishing 

After editing, all that remains is to publish the podcast. This can be done either on 

the website itself or on audio platforms such as SoundCloud or Spotify. Regardless of the 

platform chosen, you need to be aware of its rules and publishing agreements. 

6.3. Audacity 

Audacity is an impressive free and open-source audio recording and editing software. 

Don’t let the ‘free’ part confuse you. Even though it is free, it rivals any commercial audio 

software or plugin with its powerful set of features. 

You can use Audacity for varying tasks such as recording, editing, mixing audio clips, 

adding effects, conversing audio files, and more. 

So, whether you are a podcaster, vlogger, audio producer, video producer, or just 

work with sound, it’s a great tool for you. It’s very lightweight and can run on many 

operating systems and even on the oldest machines. 

Below, you will have information on Audacity’s key features, why you should use it, 

and how to use Audacity step-by-step. 

What is Audacity? 

Audacity is a free-to-use, open-source digital audio editor and recorder software 

designed for macOS, Windows, GNU/Linux, and other operating systems like Unix-like. 
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Features of Audacity 

Apart from recording audio from multiple sources, you can use this digital audio 

editing software to post-processing all audio types, such as adding normalization and fading 

in/out effects or trimming. 

Other outstanding features of Audacity include: 

• Editing multiple audio formats such as MP3, MP2, AIFF, FLAC, WAV 

• Changing the speed or pitch 

• Ability to record live sound and audio playback on PC 

• Duplicating, cutting, blending, and grafting different sound documents together 

• Scrubbing (for Version 2.1.1 and later) 

• Timer Record that enables users to schedule when a recording begins and ends 

• Noise reduction 

• Voice reduction and isolation to create isolated vocal tracks or karaoke tracks 

• Ability to save and load user pre-sets for effect settings 

• Converting cassette tapes and records into digital tracks 

 

What Can You Do with Audacity? 

In terms of what you can do, Audacity offers a wide range of uses. You can create 

interviews, work on voiceovers, edit music, record podcasts, remove/edit any kind of voice 

or sound. It’s even possible to record and mix an entire album.  You can record voiceovers, 

auto tune records, remove background noise, delete awkward silences or the parts you 

made a misspelling, and so on. 

So, what do you need to start using Audacity? 

• Set up the software. 

• A computer that supports Audacity software 

• It’s not necessary, but the sound quality will be better with an external microphone.  
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Headphones or earbuds with mics will also do based on how much voice quality you 

need. 

Audacity is very easy to use, and it is an excellent piece of software for beginners who 

want to record and edit voices and records like a pro. 

Why Should You Use Audacity? 

One of the best things about Audacity is that it allows working on complex audio 

projects longer than an hour. It is a consistent and stable software to preserve even under 

high disk usage and processor loads. 

Working with Audacity is incredibly simple. It supports the different recognizable 

audio files such as MP3 or WAV. You can directly import an existing audio file into the 

software. 

Audacity lets you record in either 16-bit or 24-bit audio. The digital recording and 

editing software can smoothly convert and combine any sounds you drag and drop into the 

interface. It does that regardless of the format. 

As for editing, users can cut, copy, paste, duplicate, trim audio or arrange multiple 

clips on the same track. Moreover, the envelope tool enables adding custom fades as well. 

Speaking of effects, Audacity provides a large pack of basic effects right out of the 

box. There are simple Bass and Treble adjustments as well as high- and low-pass filters.  

It is an easy-to-use but high in capabilities software to record, edit, and mix audio 

clips. 

How to Use Audacity Step-by-Step 

Audacity is a very straightforward audio software, so it’s easier to grasp the basics. 

Follow the steps below to learn how to use Audacity on Windows and how to use erAudacity 

on Mac likewise. 
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How do you use Audacity step by step? Here’s how: 

Step 1: Find & import the file you want to edit 

Start by importing an audio file into Audacity. It supports common audio formats 

such as MP3, WAV, and AIFF. You need to install the optional FFmpeg library for a more 

extensive range of formats. Note that Audacity cannot import copy-protected music files. 

 

To import an audio file, select File > Import > Audio. 

For a quicker method, just drag and drop the files into the Audacity window. 

Step 2: Check the waveform 

 

Stereo waveforms in Audacity look like the image above. The audio is louder where 

the waves reach or closer to the top or bottom (vice versa.) The ruler indicates the length of 

the audio clip. 

Check the waveforms to detect any DC offset, which refers to a waveform that is not 

centered on the horizontal line at 0.0 amplitude. Most of the time, it is caused by recording 

with a faulty audio interface. 

Select the clip, click on Normalize to remove the DC offset. 

Listen to the audio by clicking on the play ▶️ and stop   , or you can use the Space 

button as a shortcut to play and pause. 
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Step 3: Select and change the range of audio you want 

To change any part of your audio clip, first, select the part you want to change. You 

can cut, copy, paste, and duplicate, just like editing a selected text. 

  

The image above shows Audacity’s toolbar. So, how to zoom in Audacity? You can 

use the magnifiers to zoom in and out or  View > Zoom > Zoom In (or Ctrl + 1) and View > 

Zoom > Zoom Out (or Ctrl + 3). 

Zooming in and out helps you make the most of the window space. Once you select a 

specific range of audio and click on play, you can listen to only the selected part. 

How to split audio in Audacity? 

1. Click on the selection tool and select the split point in the clip. 

2. Then select Edit and Clip Boundaries. 

3. Select Split. 

4. Or use the keyboard shortcuts Command + I on the Mac or Control + I on the PC to 

Split the audio. 

If you make any mistakes, you can always click on Edit > Undo. 

How to trim audio in Audacity? 

Make sure to stop the audio by pressing Space if it’s still playing. Select the excerpt 

you want to delete. Click on Edit > Remove Special > Trim Audio. You can undo or redo if you 

make mistakes. After you delete the selected parts or trim the audio, the remaining excerpt 

might be away from the track’s beginning. Use Tracks > Align Tracks > Start to Zero to align 

it. 

However, this is not necessary when exporting the file because Audacity ignores the 

white space while exporting. 
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Step 4: Make the last second fade out 

How to use Audacity fade out? 

• Click the Skip to End button to go to the end of the track. 

• Zoom in to see the last one or two seconds just before the end. 

• Click the waveform one second before the end. 

• Select > Region > Cursor to Track End. 

• Then, select Effect > Fade Out to make the audio smoothly fade out. 

Step 5: Export the final version 

Mind that when you select File > Save Project > Save Project, you are just saving the 

file as an Audacity project, and it can only be opened with Audacity. If you want to open your 

file in other applications such as Windows Media Player or Apple Music/iTunes, you need to 

export it. 

Before you export the file, go to the Import/Export Preferences and see under When 

exporting tracks to an audio file, then uncheck “Show Metadata Editor prior to export step.” 

This Metadata Editor adds extra information about the voice or music into the file. 

You can always check it back if necessary. 

To Export a WAV file 

• Select File > Export > Export Audio 

• Change the file name 

• Choose a location to save 

• Select the “WAV (Microsoft) signed 16-bit PCM” from the bottom of the save dialog 

menu labeled “Format.” 

• Click Save. 

To Export an MP3 file; 

• Choose “MP3  files” in the save dialog menu. 

• Click the Options menu to set the bit rate and other options. 
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Step 6: Test your audio 

Finally, you should test the audio file you saved. Open the exported file (not the 

Audacity project file or the AUP in short) in Windows Media Player or Apple Music/iTunes 

etc. 

Don’t forget to save the changes in your Audacity project file if you want to make 

additional changes to the final version in the future. 

Getting Started with the Basics of Audacity 

How to increase volume in Audacity 

• Select a range of tracks or the whole track depending on the part you want to 

amplify. 

• Click on Effect > Amplify. 

• A window will open. Set the New Peak Amplitude to -3.0 dB (ideally.) 

• Make sure “Allow Clipping” is unchecked to prevent peaking. Then, click OK. 

How to use noise reduction in Audacity 

• Select a part of the waveform containing only noise. 

• Go to the Effects menu and select the Noise Removal tab. 

• Click on “Get Noise Profile.” 

• Select and highlight the region you want to remove the background noise. 

• Go to Effects > Noise Removal. 

• Adjust the settings and click OK. 

How to move Audio in Audacity 

• Select the Timeshift tool. 

• Select a track by clicking on the waveform. 

• Simply drag it left or right and move it anywhere on the timeline. 

How to use Audacity to record 
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• Make sure your microphone is plugged in. 

• Check your microphone and Audacity settings by going Edit > Preferences. 

Recommended settings: 

•  Audio I/O >> Recording Channels [Mono (1)] >> [OK] 

• Quality >> Default Sample Rate [22050 Hz] >> [OK] 

• Click on the red Record button to start recording. 

• Click on the yellow Stop button to stop recording. 

• Export by clicking on File > Export as. 

How to slow down audio in Audacity 

• Select the area you want to slow down. Or go to Edit > Select All to select the entire 

track. 

• Click on Effect > Change Tempo. 

• Drag the slider left to set up how much you want to slow the track down. 

• Click OK. 

How to use Auto tune in Audacity 

You need to install the GSnap plugin, which is completely free, to autotune in 

Audacity. This plugin can be used in Windows, macOS, and Linux devices. To install the 

GSnap plugin, copy its file into Audacity’s  “Plug-Ins” folder. Then, enable the plugin in 

Audacity. 

• Go to Effect > Add/Remove Plug-ins and add the GSnap plugin. 

• Then, GSnap will be listed on the Effect tab. 

• Click on it to Autotune selected audio. 

How to Bass Boost in Audacity 

• Select audio (entire track or a part of it.) 

• Go to Effects > Bass and Treble. 

• Keep the treble at zero and set up the bass levels as you like. 

• Click OK when finished. 
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⮚ Chapter 3. Guidelines to develop life skills learning in schools through 

“Didactic Pills” 

o 3.1. School education and emotional intelligence 

When the concept of Emotional Intelligence became popular in Europe too many 

pedagogues began to consider the emotional and personal side of the students. Several 

educational projects focused on the emotional part of students’ human growth; however 

today this approach is not present, in a structured and structural way, in the didactic plans of 

many countries. 

Generally, American authors see a strong relationship between emotional awareness and 

the ability to offer better and more efficient performances. Social skills are considered key to 

achieving a successful working life. Furthermore, developing social and emotional skills can 

also make a significant contribution to preventing early school leaving. Self-aware students do 

much better in their education, tend to make safer and better thought-out decisions, manage 

their emotions better, and deal with their feelings more appropriately. All this comes from 

knowing oneself. Those who do not have this ability are in constant conflict with anguish, while 

those who have knowledge of themselves are more successful in dealing with life’s problems. 

To exploit emotions to achieve a goal, it is essential to focus one’s attention, be 

motivated, competent and creative. The control of one’s emotions is the basis of all goals; the 

recognition of other people’s emotions, empathy, also comes out of self-awareness which is 

the most important of “personal skills”. Empathic people are more sensitive to other people’s 

needs and, ultimately, manage their relationships better. 

Many authors think that the school environment has a significant effect on student’s 

future behavior. The self-awareness dimension makes students more sociable and improves 

their level of understanding of other people’s problems. An effective level of social skills, also 

developed thanks to an appropriate environment, improves their approach to decision-

making situations and positively influences their social and working future. 
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The consequence is that teachers and administrators have to experiment with activities 

aimed at eliciting participation by students. 

o 3.2. Participatory learning, emotional intelligence and life skills 

Human relationships are fundamental in achieving behavioral and professional 

fulfillment. The analysis of the relationship between teacher and student must involve 

interests and objectives, since education is one of the most important resources in the 

development and acquisition of behavioral skills. This interaction is the result of the selection 

of the content, organization and systematization of teaching, which facilitate both the learning 

and the teaching process. 

In order to establish a constructive dialogue, the teacher should not consider himself the 

depositary of knowledge; first he must put himself in the position of the one who does not 

know everything, recognizing that even an illiterate person can be the repository of the most 

important knowledge5. 

Learning becomes more interesting when the student feels responsible for his own 

competence and the motivational method used in the classroom. The pleasure in learning is 

not an activity that arises spontaneously, since learning is not a task that students carry out 

with satisfaction and is seen in some cases as an obligation. For better results, the teacher 

should stimulate students’ curiosity by following their actions during the development of the 

activities. 

In practice, the construction of knowledge is not an individual task but is the product of 

human activity marked by social and cultural life. The teacher’s role is to act as a learning 

stimulator through constructive assimilation of the teachings. The lesson is a challenge that 

students must participate in, not sleep. The state of “tension” is linked to the fact that students 

have to follow the teacher’s thoughts, be surprised by his pauses, his doubts, his uncertainties. 

 
5 GADOTTI, M. História das idéias pedagógicas. 8. ed. São Paulo: Ática, 1999. 
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Therefore, the relationship between teacher and student depends mainly on the climate 

created by the teacher, the empathic relationship created with the students, the ability to 

listen and reflect the students’ level of understanding and the creation of a bridge between 

knowledge and them. The teacher, the educator of the industrial age should try to educate to 

change, autonomy and possible freedom in a global approach, working on the positive part of 

the students, for the formation of citizens aware of their duties and social responsibilities. 

Regarding educational practices in the relationship between teacher and student, 

teachers should: 

⮚ Improve the level of autonomy of students, recognizing initiative and 

responsibility, the ability to reflect and organize their own learning; 

⮚ Establish cooperation; 

⮚ Give priority to teaching through the development of projects, investigate and 

promote the “culture” of research; 

⮚ Find ways of working that involve parents and the community in general; 

⮚ Encourage peer assessment practices (among students) and develop the 

necessary methodologies and tools. 

⮚ These completely new scenarios make teaching a challenge for educators. The 

changes range from lesson planning to relationship with students. 

In general terms, the Participatory Learning Approach (PLA, called “play”) requires the 

active participation of students in their educational action. The core of the idea of 

participatory educational action is that students identify issues or projects, put them into 

practice and then evaluate the solutions provided with a peer activity; each step can be 

performed by individuals or by a group. Students should be able to observe everything their 

partners do, so that they can learn further from each other’s attempts. 

Furthermore, listening skills are an essential aspect of motivation, enabling students to 

develop their critical thinking communication skills necessary to perform a function 

competently in their social environment. It is generally established that developing an active 
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listening skill is essential for developing a negotiating language outside the purely scholastic 

dimension. 

o 3.3. Approaches and tools for learning life skills  

The educational process is based on some general principles such as motivation and 

interest in what teaching should generate in the minds of students. Interest can be aroused in 

students thanks to the participatory learning approach. When students apply what they learn 

in daily activities, this creates interest and participation in teaching and, more generally, in 

school activities. Here comes the relevance of life skills education, also called life skills, 

through which we can put into practice all the good principles of teaching effectively (helping 

the student to recognize his talents, to relate lesson subjects to real life, to use leisure time to 

stimulate creative thinking, etc).  

Life skills education techniques such as games, role play, debate or discussion make the 

learning process interesting and the student automatically develops the motivation to study. 

In this regard, there are multiple references in the literature, which refer to guiding 

approaches to teaching life skills, whatever the context in which they are the object of 

learning. The general indications provided refer to the following 4 phases: 

1. Prepare, in agreement with the relevant parties (stakeholders), the curricular program 

dedicated to life skills, in relation to the reference target 

2. Train trainers on life skills and on possible ways to activate student involvement and 

make learning participatory 

3. Create the reference context to allow the learning of life skills, i.e. select the 

methodologies and interactive tools through which to ensure the best possible 

learning 

4. Monitor and evaluate the teaching program focused on life skills in order to refine it 

based on the results achieved. 
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The choice of methods for teaching life skills depends on the training situations, since 

each group has its own needs and each teacher has his or her own communication and 

teaching style. 

Certainly, as anticipated, interactive teaching methods are the most suitable for activating 

life skills, since they aim at the direct intellectual, emotional and affective involvement of the 

student. In this regard, we try to illustrate some interactive teaching methods and techniques 

that can be used with the aim of training participants on these skills6. 

TEACHING 

METHOD 

DESCRIPTION AND PROCESS 

Action learning Students are involved in solving a problem mainly through group work, during 

which students develop a far-reaching solution, justify the chosen solution and 

present their proposals. A group of teachers discuss the results presented and 

nominate a winner, making the evaluation more objective. 

This method is particularly effective if used during a work experience, as it 

allows you to support the student in identifying a solution to a practical 

problem and, therefore, also facilitates his or her empowerment. 

Peer feedback In a pair of students, one provides the other with continuous feedback on 

his/her activities and decisions. The participants involved (who acts and who 

provides feedback) must be on an equal footing. This allows the teacher to 

understand the strengths and weaknesses of each of them and help them 

develop adequate self-esteem. 

The application of this method assumes that students are trained to provide 

the required feedback and to express competent judgments. 

 
6 Interactive teaching methods in contemporary higher education, Nadezhda O. Yakovleva, Evgeny V. Yakovlev, 
Department Pedagogy and Psychology, Chelyabinsk State Pedagogical University, Russia, Russian-British Institute 
of Management, Russia. 



 

 

 

 
 

Page 89 of 114 
This project has been funded with support from the European Commission. This publication reflects the views only of the authors, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 
 

TEACHING 

METHOD 

DESCRIPTION AND PROCESS 

Behavioural 

modelling 

It starts with the presentation of a professional behavior model and the 

student must try to replicate the proposed behavioral model. At the end, the 

teacher evaluates the degree of success of mastering the professional 

behaviors to be learned. 

The method is more effective in the presence of the following conditions, if 

the case presented: 

- it is attractive for students who must be interested in following the proposed 

model 

- shows the desired sequence and the correct procedure to follow 

- highlights the relationship between the desired sequence of activities and 

the resulting benefits (time saving, error reduction, problem solving, etc.). 

Case study method It is aimed at educating by solving specific cases. 

Students are asked to find the solution to a represented case and, in defense 

of their solution, provide an analysis of the situation. 

Students acquire team working skills, creativity for finding the solution, 

autonomous reasoning, self-esteem and the ability to defend their opinions 

and choices. The result is therefore a well-formed personality. 

The teacher’s activity develops as follows: 

▪ Case setting, formulation of questions for the analysis and 

development of support materials for students to be able to manage 

the work independently; 

▪ Preparation of introductory and closing notes, organization of the 

discussion and acquisition of the students’ contribution to the analysis 

of the situation; 
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TEACHING 

METHOD 

DESCRIPTION AND PROCESS 

▪ Interventions in a simplified and instructor mode rather than as a 

source of questions and knowledge. 

Students develop the following activities: 

▪ Analyze the case presented, its content and characteristics; 

▪ Identify the main problems, factors and activities that can really work; 

▪ Identify possible solutions; 

▪ Analyze the consequences of the possible solutions identified; 

▪ Identify the best solution and its consequences, identify potential 

problems, mechanisms and corrective measures. 

Metaphor game Proverbs, tales, fables and legends are used that evoke the future problems 

of life and are, in fact, used as metaphors. It is aimed at developing new 

activities and changing behavioral attitudes, using a metaphorical game. 

The group selects a metaphor and works to find a way to solve the problem 

and apply the solution (defining the action strategy). When the game is over, 

the problem is discussed to find effective solutions and apply it to the work 

situation. 

This form of teaching helps to develop student’s creativity, reduces anxiety in 

solving problems, encourages autonomy, etc. 
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TEACHING 

METHOD 

DESCRIPTION AND PROCESS 

Storytelling Telling a story teaches future professional and life “rules” with the help of 

myths and stories of ordinary life. By telling a story, the teacher prepares the 

student to understand situations and how to deal with them. Objective 

information should be provided. 

To make this method productive and effective, history must: 

- be simple and clear. One or two main points must be identified 

- have contents related to the life of the participants (students) 

- be compelling enough to be interesting. 

- include situations of happiness, sadness, enthusiasm, courage, 

serious thoughts, decisions and behavior that solve a problem. 

This method promotes identification with the topics covered and a greater 

awareness of one’s feelings and moods. Working with Storytelling means 

strengthening identity, self-esteem, comparison with others, recognition, 

personal growth and acceptance. 

 

In all situations, teachers should remember that their primary role is as facilitators, not as 

“teachers”. In this regard, it is necessary to follow some recommendations for lessons focused 

on life skills7: 

- Tackle only one life skill per lesson, but if the teacher decides to combine two, it is 

recommended that they are similar or such that they can be combined with each other 

 
7 Strengthening Life Skills for Youth. A Practical Guide to Quality Programming, GLOBAL PARTNERSHIP FOR 
YOUTH EMPLOYMENT, 2014 International Youth Foundation (IYF). 



 

 

 

 
 

Page 92 of 114 
This project has been funded with support from the European Commission. This publication reflects the views only of the authors, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 
 

- The duration of the lessons on life skills should be limited to a duration of between 45 

minutes, useful to allow a comparison on the problem and to try their hand at various 

activities, and a maximum of 75 minutes (in order not to exceed the attention 

threshold of the participants) 

- The lessons on life skills must be frequently and regularly managed to encourage group 

dynamics between students and between them and the teachers. Between one 

training session and the next it is advisable to recur at least the interval of one week 

to maintain interest among the participants, but at the same time there should be no 

more than two lessons per week, to allow self-reflection and practice. 

In addition, to ensure greater effectiveness in learning life skills, each lesson must be divided 

into the following three phases: 

1. Information. Each lesson should dedicate an introductory space to the description of the 

life skill that will be covered. To keep the attention of the participants alive, it is advisable to: 

- contextualize the specific life skill in a scheme of everyday life and show how it can 

influence behavior 

- give information quickly and easily 

- choose positive messages instead of negative ones. 

2. Practice. Participants should have time in class to: 

- Familiarize with the ideas, terminology and behaviors related to each life skill 

- Brainstorm and discuss the implications of the life skill dealt with for oneself and for 

others, in order to fully internalize its meaning and importance 

- Imagine real life situations, placing itself at the center of the scene as actors in the 

process of its own change. 
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3. Self-reflection. Participants should have time for personal reflection and analysis, to help 

their transition from the classroom context to how they imagine applying the knowledge 

acquired in their daily life. 

o 3.4. Operational guidelines: the “Didactic Pills” of 4G Project 

As part of the “4G Didactic Pills” project, the storytelling method was used, conveyed 

through digital devices, in order to make teaching even more attractive considering the target 

audience (14-year-old students). 

Didactic Pills can assist teacher in carrying out activities aimed at acquiring the so-

called Life skills which, as defined by the WHO (World Health Organization), are “all those skills 

necessary for to relate to others and to deal with the problems, pressures and stresses of daily 

life. The lack of such socio-emotional skills can cause, especially in young people, the 

establishment of negative and risky behaviors in response to stress: suicide attempts, drug 

addiction, cigarette smoking, alcoholism, etc.”. 

The pills, prepared as part of the 4G Project, are usable, as anticipated, on digital 

devices such as PCs or smartphones, as well as on notebooks. 

They have been designed around 10 life skills: Creativity, Critical Spirit, Decision Making, 

Effective Communication, Empathy, Emotion Management, Problem Solving, Self-Awareness, 

Effective Relationships, Stress Management. 

o 3.4.1. Digital storytelling 

The method used to facilitate Life skills learning is digital storytelling. Digital Storytelling, or 

Narration created with digital tools (web apps, webware), consists in organizing content, 

through a narrative structure, in order to obtain a “stimulus story”. This type of 

communication guarantees the learning of life skills: 
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- fascination, deriving from the fabulous character that the stories possess, because 

they are tales that deal with everyday problems and dynamics that students most likely 

recognize as “real” 

- involvement, determined by the narrative mode that allows you to easily convey 

abstract and apparently complex content for students and to activate processes such 

as that of identification, favoring a pleasant and interesting learning experience 

- strong contextualization, as each problem is inserted in a narrative that has very clear 

meaning and purpose 

- brevity of the training contents, which young people are now increasingly accustomed 

to 

- ease of use of the learning tools, technological devices that can also be used in 

mobility, which children manage with extreme ease and which now represent one of 

the main tools for relating to the outside world. 

We believe that the smartphone (or tablet) as a learning tool could become a powerful 

inclusive device for students with special needs. In fact, unlike the technologies specifically 

used for this target, technological devices such as smartphones or tablets (in addition of 

course to the notebook) are indistinguishable from the devices used by other students. 

o 3.4.2. Life skills education management through 4G Project’s stories 

Let’s see in detail the functioning of the Platform that contains the didactic pills. 

There are 10 didactic pills related to the 10 life skills mentioned above. 

Each pill focuses on a single life skill and is made up of 3 stories on average. 

The pills and related stories can be reached by connecting, as “host”, to the following 

link: 

https://euprojects.giuntipsy.com/course/index.php?categoryid=2  

https://euprojects.giuntipsy.com/course/index.php?categoryid=2
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The platform where the Didactic Pills are loaded will ask for your username and 

password, but you choose to log in as a guest and you will not have to register to use the 

Didactic Pills. 

On the page that contains the pills you will also find a file that allows you to note 

whether you have chosen the most effective way or not, in order to have a memory of the 

choices made. 

 

 

Each story contains: 
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- a title and a subtitle (eg. Title: “Memories of grandparents”, Subtitle: “How to 

transform a problem into an opportunity”); 

- a story, which presents a problematic situation; 

- two possible scenarios/solutions, in response to the problematic situation presented, 

elaborated in such a way as not to be immediately “correct (s)” or “wrong (s)”; 

- once the preferred solution has been selected, between the two proposals, the 

epilogue of the story and the related comment. 

Didactic pills can be used by the student both directly in the classroom and remotely, 

independently, outside the school environment. 

Once a life skill has been selected from the 10 provided, the student “faces” the stories 

proposed as part of the didactic pill chosen. The stories must necessarily be enjoyed in the 

order proposed (story 1, story 2, story 3, etc.). 

 

While reading each story, the student can take notes, using the appropriate function 

at the top right. 

In addition, the function at the bottom right allows to share the link of the story on social 

networks, on teams and Google Classroom or on a certain web page or, finally, to send it by 

e-mail. 
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For the debate management, it is necessary to accompany the students in the 

comparison by building a non-evaluative context in which the relationships are based on 

acceptance and empathy, rather than on competition and performance. The objective of the 

comparison is to identify the reasons why the choice identified as the best is such. 

At the end of the comparison, the certificate on the individual Life skill can be issued. 

The certificate is issued by the platform only upon the use of all the stories related to the single 

Life skill. 

The teacher completes the certificate issued by the platform manually entering, once 

printed, the student’s name and surname and the life skill attended. 

Access to the platform containing the educational pills does not require the prior 

assignment of a user name. To use the teaching materials provided, as seen, just connect to 

the following link: 

https://euprojects.giuntipsy.com/course/index.php?categoryid=2  

and from here access the path in one of the languages of the 4G Project (English, Bulgarian, 

Czech, Italian, Portuguese, Spanish) 

Otherwise, you can directly access the following links for the individual languages of 

the Project: 

https://euprojects.giuntipsy.com/course/view.php?id=14  (Bulgarian version) 

https://euprojects.giuntipsy.com/course/view.php?id=13  (Czech version) 

https://euprojects.giuntipsy.com/course/view.php?id=10  (Italian version) 

https://euprojects.giuntipsy.com/course/view.php?id=12  (Portuguese version) 

https://euprojects.giuntipsy.com/course/view.php?id=11  (Spanish version) 

https://euprojects.giuntipsy.com/course/view.php?id=3  (English version) 

https://euprojects.giuntipsy.com/course/index.php?categoryid=2
https://euprojects.giuntipsy.com/course/view.php?id=14
https://euprojects.giuntipsy.com/course/view.php?id=13
https://euprojects.giuntipsy.com/course/view.php?id=10
https://euprojects.giuntipsy.com/course/view.php?id=12
https://euprojects.giuntipsy.com/course/view.php?id=11
https://euprojects.giuntipsy.com/course/view.php?id=3
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Platform tracks the accesses but does not allow to attribute a relationship between the 

access and the user, in compliance with the privacy legislation. The accesses are not stored by 

the platform. Therefore, it is possible to use the same didactic pills several times. 

o 3.4.3. Possible further uses of the Platform 

4G Project provides the architecture of Didactic Pills and the Genially software structure 

to create new stories. 

The design of new stories, using the articulation proposed by 4G teaching Pills, can be 

carried out by teacher independently or even in collaboration with the students. 

Storytelling is a tried-and-tested method in education, be it by writing a book, oral 

storytelling, or through presentations. In fact, a study by MacDonald8 detailed that societies 

have used storytelling to teach key principles throughout millennia. Likewise, other authors9 

explain that storytelling has been used as an information medium in education of all types, 

including in dentistry, general medicine, law, and business. 

Technologies of the 21st century allowed to storytelling to take a new form. It has 

become richer with the incorporation of digital media like videos, audio files, as well as images.  

The method that is called digital storytelling was born. In its simplest form, digital 

storytelling refers to the practice of using IT tools to tell stories or present ideas but also refers 

to the use of multimedia presentations that combine a variety of digital elements within a 

narrative structure. As opposed to traditional storytelling that uses materials on physical 

media such as paper, tapes or discs, and film, a digital story uses material that exists on 

electronic files. As such, digital stories may include not only text, images, video, and audio, but 

also interactive elements like maps and social media elements like tweets.  

 
8

 MacDonald, M. R. (Ed.). (1998). Traditional Storytelling Today: An International Sourcebook. Chicago, IL: Fitzroy Dearborn 
Publishers 
9

 Andrews, D. H., Hull, T. D., & Donahue, J. A. (2009). Storytelling as an instructional method: Descriptions and research 

questions. The Interdisciplinary Journal of Problem-based Learning, 3 (2), 6-28 
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Educators in the 21st century believe that technology can be an effective tool in 

educating the new generation, making learning goals easier to achieve. Teachers can create 

digital storytelling to generate interest and engagement for students of the “YouTube 

generation”10. Digital stories can appeal to diverse learning styles, allowing instructors to 

present abstract or conceptual information in a more understandable way. 

Multimedia tools such as digital storytelling provides students with opportunities to 

participate and interact in the classroom, while gaining new skills such as synthesis, analysis, 

and evaluation11. Different benefits are associated with using digital storytelling as an 

educational tool: 

● Digital storytelling creates space for meaningful listening. Digital stories provide 

students with the opportunity to digest information in a meaningful way. Digital stories 

allow teachers to genuinely engage students in the story’s message. 

● Digital storytelling persuades the brain and the heart. Digital stories can teach students 

the value of emotional rhetoric, allowing them to explore new ways of acting or 

thinking differently. These stories can elicit emotional responses in students and 

encourage them to pursue topics that they’re passionate about. 

● The method allows students to showcase their learning to their peers. Students benefit 

not only from receiving information through digital stories but also from making digital 

stories that feature their experiences and learnings. The many aspects of creating a 

digital story improve students’ soft skills and hone research and writing skills as well. 

Here are some simple steps that a teacher can follow to design digital stories12: 

1. Choose a Topic Begin by thinking of the purpose of the story (to inform, convince, 

provoke, question) 

 
10

 Dreon, O., Kerper, R. M., & Landis, J. (2011). Digital storytelling: A tool for teaching and learning in the YouTube 

generation. Middle School Journal, 42 (5), 4-10 
11

 Alismail, H. A. (2015). Integrate digital storytelling in education. Journal of Education and Practice, 6 (9), 126-129. ERIC 
12

 Here are some simple steps that a teacher can follow to design digital stories 
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2. Conduct Research on the Topic using online search engines, without forget that the 

library can also be a useful research tool.  

3. Write the First Draft of the Script, useful even for the story’s audio narration. Read 

aloud what written, making sure that the purpose of the story is clearly articulated and 

includes an identifiable point of view. In this regard, speaking of script it is suggested 

to: 

✔ focus on a specific topic/problem, in the case of the 4G Project, a problem that 

can be solved through the correct exercise of a life skill 

✔ be short, because the story needs to take a few minutes to pay attention to 

✔ foresee a narrative arc composed of three parts: a beginning, a central part and 

an end. The beginning is where the scene is set and the plot begins. The central 

part is where more details are provided on the topic or problem in question. The 

story should be built towards a climax or resolution. The end of the story is where 

the issues are resolved. The didactic pills of the 4G Project have a structure 

divided into 3 steps, with respect to which, in the central section, two possible 

scenarios/solutions must be placed, in response to the problematic situation 

presented in the previous part, and in the last part the two are highlighted 

related epilogues of the story. The two epilogues of the story also include a 

comment that aims to present the “value” of the life skill for the purpose of a 

“positive” solution to the story told 

4. receive feedback on the script to understand if and how it is appropriate to make the 

story clearer or more useful 

5. revise the script, based on the feedback received, to get a better result 

6. find, create and add images, for example using a specific online search tool for images, 

such as Google Image Search but also using photos taken with a digital camera. 

Attention should be paid to any copyrights 

7. create a storyboard, i.e. a written or graphic overview of all the elements that you 

intend to include in the digital story, in order to visualize the story before it is created, 

when it is easier to make changes or add new content 
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8. record the audio narration through a high-quality microphone or a voice recording app 

on a smartphone  

9. add background music (optional) appropriate to the theme of the story 

10. create the digital story by selecting the software tool to use (see previous sections) 

11. Publish the digital story online in places like YouTube, Google Drive, Microsoft 

OneDrive, Dropbox, etc. 

If the above activities are carried out together with the students, the teacher’s work can 

be divided into the following phases of activity: 

- Analysis: Educators help students identify an instructional goal and analyze aspects of 

the digital story related to the topic and script, as well as consider the potential 

audience for the story 

- Design: Educators help students complete the script and storyboard for the design of 

the story as well as collect and organize appropriate media such as images, audio and 

video. 

- Development: Educators help students use technology hardware and software to build 

the story. 

- Implementation: Educators help students plan how the story will be used and create 

additional resources including lesson plans, handouts, and other supporting materials. 

- Evaluation Phase: Educators use a variety of measures to determine if the students 

achieved the goal for the digital story project or need to revise the story and 

supplemental materials based on this input. 

 

 

  



 

 

 

 
 

Page 102 of 114 
This project has been funded with support from the European Commission. This publication reflects the views only of the authors, and the 
Commission cannot be held responsible for any use which may be made of the information contained therein. 
 

⮚  

⮚ Chapter 4. Practical examples of “didactic pills” usable on mobile devices 

(ready media content as photos, pictures, animations, podcast records etc.) 

4.1. Practical examples of “didactic pills” done by Kahoot 
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4.2. Practical examples of “didactic pills” done by Genially 

 

●  

 

https://euprojects.giuntipsy.com/pluginfile.php/59/mod_resource/content/2/genially.html 

  

https://euprojects.giuntipsy.com/pluginfile.php/59/mod_resource/content/2/genially.html
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4.3. Practical examples of “didactic pills” done by Canva 
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4.4. Practical examples of “didactic pills” done by Audacity 

You have a scenario with options. Just record the story, options and explanations. At the end 

will have short audio story with options for decisions and explanations. The length could be 

up to 5 min. 

Elements of the 4GDP Text 

TITLE of the Story Time to act! (Empathy) 

Short description  Doing something before it is too late 

Story / Scenario Peter, 12 years old, has recently arrived to town with his parents. He is new at 

school and is struggling to make new friends and feel included. But it hasn’t been 

an easy path. Peter seems to be very shy and is alone all the time he is at school. 

In class, teachers try to call him to participate but he rarely says a word: shyness 

or cognitive difficulties? Also, Peter wears the same clothes for more than one day, 

which is quite strange for his classmates. Shortly, they start to make fun of him 

and to call him some bad names. Instead of helping him to feel good and 

welcomed, they chose to pursue him, laugh at him, steal his schoolbag, etc.  

Susan, one of the girls of the class, was feeling very upset and even ashamed about 

her mates’ attitudes. She couldn’t handle to see the bullying her friends were 

making to Peter. He was already sad and lonely enough for starting a new life in a 

new town and city, why are they doing that to him? What is the sense of such cruel 

attitudes? What do they want?  

This morning, Susan has found Peter crying outside and, after that, he hasn’t come 

back to classes. Susan is really worried about him, she feels a tightness in her chest 

and can’t stop thinking about Peter. She finds herself imagining how she would 

feel if she was the one being bullied… How would she react? Would she handle it? 

Susan feels like she should do something… but, although deeply touched about the 

situation and extremely sad, she feels insecure and uncertain about what to do. 

Option 01 Susan has slept very little the whole night. She couldn’t stop thinking about Peter 

and the pain he might be going through being bullied all the time. Susan would like 

to do something to help him, but she is afraid of retaliation in case she reports the 
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situation to a teacher. What if they start to bully her as well? Maybe that is 

happening while it is a new situation and, soon, her mates will stop bullying Peter. 

So, Susan decides to approach Peter, be with him during the breaks and make him 

feel more comfortable at school. She believes that, by doing so, her mates will stop 

teasing on Peter and persecuting him. 

Option 02 Susan has slept very little the whole night. She couldn’t stop thinking about Peter 

and the pain he might be going through being bullied all the time. Although a bit 

afraid of losing her friends, she really thinks that what they are doing to Peter is 

very serious and can have severe consequences to him. She has already heard 

about victims committing suicide and that is horrible! However, she is too young 

to take such a thing on her shoulders by her own. So, she decides to look for their 

class tutor at school and tell her what has been happening since Peter joined the 

class. 

Answers/Explanations 

01 

The next day, Peter has returned to school. He looks even more frightened than 

before. Susan does how she has planned: she waits for him after each class and 

never lets him alone. At first, he seemed suspicious about her intentions, but 

gradually he starts to become more relaxed and starts talking to Susan. Susan is 

very happy, she could finally see a shy smile on his face! Peter is really nice, polite 

and they has several interests in common! She is absolutely sure that her 

classmates will like Peter as well! 

However, on the second day, things change… Her classmates start to be rude at 

her and to press her to not talk to Peter. She refuses to do so and tries to make 

them see how unfair they are being, condemning their attitudes and asking them 

to put themselves on Peter’s shoes. However, they do not care about what Susan 

is saying and start to tease on her as well. From that moment on, Susan becomes 

the bullies’ new target: they steal her lunch packs, call her bad names, humiliate 

her in the corridors, ignore her when she tries to talk, etc. Things get worse and 

worse! Now, both Susan and Peter are victims of the group despicable attitudes. 

Susan thought that she could solve the problem by herself, but it only got worse! 

It is very good that you feel touched by the situation and want to help, but bullying 
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is a very complex and serious problem and involving an adult is always the right 

thing to do.  

Answers/Explanations 

02 

Susan meets the class tutor the next morning and tells her everything Peter has 

been going through since he joined the class. The teacher gets really surprised 

because they usually are very kind and friendly. She has noticed that Peter is very 

quiet and shy, but she thought he was still adapting to the new reality and missing 

his old friends. The teacher thanks Susan for her empathic attitude and for having 

shared what is happening in the class.  

The teacher prepares a class about bullying. At first, the class is totally silent but, 

as the session goes on, they start participating and asking questions about the 

issue. Peter, however, keeps in silence with his head down. Suddenly, John asks 

for permission to talk and goes to the front of the class. He tells the teacher that 

he has been acting like a bully since Peter join them. He does not know to explain 

why he did it… he just wanted to have fun and didn’t think about how Peter, and 

then Susan, were feeling. It gave him a sense of superiority and the centre of 

attention… By then he was enjoying the feeling, but now he realized how mean 

and stupid he has been. He apologizes Peter and Susan, also the rest of the class, 

for all the shameful attitudes he and his group have been having. He hugs Peter 

and Susan and promises not to repeat his behaviour. 

Susan was able to put herself on Peter’s shoes and, this way, she could help him 

and change mentalities and attitudes. Before judging, always think how it would 

be if it was you. 
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⮚ Partnership 

 

 
Evropska rozvojova agentura, 

s.r.o. 
Czech Republic 

EUDA is a private company acting as a head of an EU-wide network of 
institutions and experts in education, innovation and regional 
development. 
Contact 
Address: Na Čihadle 959/55 – Praha 
Email: martin.rejmis@eracr.cz 
Web: www.eracr.cz 

 
TIBER UMBRIA COMETT 

EDUCATION PROGRAMME 
Italy 

TUCEP is a no profit Association of twelve Italian Universities and 
numerous Enterprises, and Public Authorities created in 1992 
under the EU COMETT Programme. 
Contact 
Address: Piazza dell’Università, 1 – 06123 Perugia 
Email: tucep@tucep.org 
Web: www.tucep.org 

 
Artes Srl Italy 

Artes srl is a company born in 2008 collaborates with Trade Unions 
and Business Associations at EU and national level and it has carried 
out important research works for Interprofessional Funds 
Contact 
Address:  via della ninfa, 23 – 06132 Perugia 
Email:  info@artesinlinea.it 
Web: http://www.artesinlinea.it/ 

 
GIUNTI PSYCHOMETRICS SRL 

Italy 

Founded in Florence in 1950, as Giunti O.S. Organizzazioni Speciali ( 
now Giunti Psychometrics) is the Italian leading publisher of 
psychodiagnostic tests and tools, in terms of catalogue, history and 
specific market. 
Contact 
Address: VIA FRA' PAOLO SARPI 7° - 50136 Firenze 
Email:  paolo.lippi@giuntipsy.com 
Web:  www.giuntios.it 

 
INSTITUT ZA PODGOTOVKA 

NA SLUJITELIV 
MEJDUNARODNI 

ORGANIZACII ZDRUZHENIE 
Bulgaria 

The Institute for Training of Personnel in International Organizations 
(ITPIO) is a private non-profit organization – NGO with the status of 
Association, established in 2010. 
Contact 
Address: BUL SKOVELEV 42 ET 6 AP 11 – 1606 Sofia 
Email:  kovachev@itpio.eu 
Web: www.itpio.eu 

mailto:martin.rejmis@eracr.cz
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mailto:tucep@tucep.org
http://www.tucep.org/
mailto:info@artesinlinea.it
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ASOCIACION CULTURAL 

EUROACCION MURCIA Spain 

Euroaccion is a non-governmental and independent organisation for 
the support of youth and adult learning and the professional and 
personal development of people with fewer opportunities. Its 
mission is to inspire and stimulate human potential through 
experiential learning, non-formal education, and volunteering and 
social inclusion projects. 
Contact 
Address: Avenida Primero de Mayo 20, 1°B, 30120 El Palmar, Murcia 
Email: euroaccion@gmail.com 
Web: www.euroaccion.com 

 
Vocational school of Agro 

technology "Tzanko 
Tzerkovski" Bulgaria 

Tsanko Tserkovski Vocational High School of Agrarian Technology is a 
municipal school with a 99-year history. 
Contact 
Address: blvd. "Riski" 46, 5200 Pavlikeni 
Email: vitljanov@abv.bg 
Web: http://pgat-pavlikeni.com 

 
AEVA - ASSOCIACAO PARA A 
EDUCACAO E VALORIZACAO 

DA REGIAO DE AVEIRO 
Portugal 

AEVA (Association for the Education and Valorisation of Aveiro 
Region) (www.aeva.eu) was founded in 1998 as a non-profit 
organisation to meet the needs of local businesses in 
tackling skills mismatch by bringing education and the working world 
closer together. 
Contact 
Address: Apt. 567 - 3800-510 AVEIRO 
Email: ana.ribeiro@aeva.eu 
Web: www.epa.edu.pt 
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